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REFERENCES

CONVENTIONS

This manual uses the following conventions:

"User" refers to anyone using a Matrix 300™ reader.
"Reader" refers to the Matrix 300™ reader.

"You" refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a Matrix 300™ reader.

REFERENCE DOCUMENTATION
For further details refer to: the VisiSet™ Help On Line, Matrix Reading Methods, Matrix Host

Mode Programming, Matrix SW Parameter Guide, Matrix Code Quality Verifier Solution
provided as supplementary documentation on Mini-DVD.

SUPPORT THROUGH THE WEBSITE

Datalogic provides several services as well as technical support through its website. Log on
to www.datalogic.com and click on the Industrial Automation links for further information:

e Products - Industrial Automation - Identification

Select your product from the links on the Identification page. The product page
describes specific Info, Features, Applications, Models, Accessories, and Downloads
including documentation, software drivers, and the VisiSet™ utility program, which allows
device configuration using a PC through Serial and Ethernet interfaces.

e Support & Services - Industrial Automation

Several links from the Industrial Automation list take you to additional services such as:
Service Program which contains Maintenance Agreements and Warranty Extensions;
Repair Centers; On-Line RMA Return Material Authorizations; Technical Support through
email or phone, Partner Program; Downloads for additional downloads.

PATENTS

This product is covered by one or more of the following patents:

Utility patents: US6,512,218 B1; US6,616,039 B1; US6,808,114 B1; US6,997,385 B2;
US7,053,954 B1;, US7,387,246 B2; USS8,058,600 B2; EP996,284 B1; EP999,514 B1;
EP1,014,292 B1; EP1,128,315 B1; EP1,396,811 B1; EP1,413,971 B1; JP4,435,343 B2,
JP4,571,258 B2.

Additional patents pending.

Vi



COMPLIANCE

For installation, use and maintenance it is not necessary to open the reader.

Only connect Ethernet and dataport connections to a network which has routing only within the plant
or building and no routing outside the plant or building.

EMC COMPLIANCE

In order to meet the EMC requirements:

e connect reader chassis to the plant earth ground by means of a flat copper braid shorter than
100 mm;

e connect pin "Earth" of the CBX connection box to a good Earth Ground;
e for direct connections, connect your cable shield to the locking ring nut of the connector

POWER SUPPLY

ATTENTION: READ THIS INFORMATION BEFORE INSTALLING THE PRODUCT
This product is intended to be installed by Qualified Personnel only.

This product is intended to be connected to a UL Listed Computer (LPS or “Class 2") which supplies
power directly to the reader, or a UL Listed Direct Plug-in Power Unit (rated 10 to 30 V, minimum 1 A)
marked LPS or “Class 2", or Power over Ethernet source Device supplied by UL Listed Direct Plug-in
Power Unit marked LPS or “Class 2”".

CE COMPLIANCE

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

FCC COMPLIANCE

Modifications or changes to this equipment without the expressed written approval of Datalogic could
void the authority to use the equipment.

This device complies with PART 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference which may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

Vii



LASER SAFETY

The Matrix 300™ internal illuminators contain two aiming Laser LEDs used to position the
reader.

Therefore the product is classified as a Class 2 laser product according to IEC 60825-1
regulations and as a Class Il laser product according to CDRH regulations. Disconnect the
power supply when opening the device during maintenance or installation to avoid exposure
to hazardous laser light. The laser beam can be switched on or off through a software

JL 3
mmw_wazﬁmm

This product is covered by one or more of the following US pat.:
US6,512,218 B1; US6,616,039 B1; US6,808,114 B1;
US6,997,385 B2; US7,053,954 B1; US7,387,246 B2;
US8,058,600 B2.
See product manual and package for complete patent Esfing.
LASER LIGHT - DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT
MAX CUTPUT RADIATION 1 mwW

EMITTED WAVE LENGHT 630 — 680 nm
1EC 80825-1: 2007

Complies with 21 CFR 1040. 10
except for deviations pursuant
to Laser Notice N°50.
date June 24, 2007

DATALOGIC Automation S.r.L
Via Lavino, 265 - 40050 Monte San Pietro (BO) Raly

® veww datalogic.com ®

LED SAFETY

LED emission according to EN 62471.
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HANDLING

The Matrix 300™ is designed to be used in an industrial environment and is built to withstand
vibration and shock when correctly installed, however it is also a precision product and
therefore before and during installation it must be handled correctly to avoid damage.

e avoid that the readers are dropped (exceeding shock limits).

A\

e do not fine tune the positioning by striking the reader or bracket.

NO
//ni




e do not weld the reader into position which can cause electrostatic, heat or reading window
damage.

¢ do not spray paint near the reader which can cause reading window damage.




GENERAL VIEW

Matrix 300™
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Figure A

Connector block
rotates to 90° position

@ Device Class Label Q Power - Serial Interfaces - /O Connector
@ Bracket Mounting Holes (4) @ Ethernet Connector

@ Good Read LED (green) a No Read LED (red)

@ Lens Cover @ Aiming System Laser Pointers

@ HMI X-PRESS™ Interface @ Ethernet Connection LED

@ Lens @ Power On LED
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RAPID CONFIGURATION G

1 RAPID CONFIGURATION

STEP 1 - CONNECT THE SYSTEM

To connect the system in a Stand Alone configuration, you need the hardware indicated in
Figure 1. In this layout the data is transmitted to the Host on the main serial interface. Data
can also be transmitted on the RS232 auxiliary interface independently from the main
interface selection.

When One Shot or Phase Mode Operating mode is used, the reader is activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

_Unu)uumOOO ! rost

CAB-DSxx
©
=0 cBX
Matrix 300™ _
_ @ Main Serial Interface (RS232 or RS485/422 Full-Duplex)
| @ External Trigger (for One Shot or Phase Mode)

[ ] @ 1/10, Aux

Figure 1 — Matrix 300™ in Stand Alone Layout
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CBX100/CBX500 Pinout for Matrix 300™

The table below gives the pinout of the CBX100/CBX500 terminal block connectors. Use this
pinout when the Matrix 300™ reader is connected by means of the CBX100/CBX500:

CBX100/500 Terminal Block Connectors

Input Power Outputs
Vdc Power Supply Input Voltage + +V Power Source - Outputs
GND | Power Supply Input Voltage - -V Power Reference - Outputs
Earth | Protection Earth Ground O1+ Output 1 +
O1- Output 1 -
Inputs 02+ Output 2 +
+V Power Source — External Trigger 02- Output 2 -
I1A External Trigger A (polarity insensitive
11B External ._._‘_MMQ\ B Mno_mzﬁw _:mm:m:_<mw O3A Output 3 (CBX500 only)
-V Power Reference — External Trigger
+V Power Source — Inputs Auxiliary Interface
12A Input 2 A (polarity insensitive) X Auxiliary Interface TX
12B Input 2 B (polarity insensitive) RX Auxiliary Interface RX
-V Power Reference — Inputs SGND | Auxiliary Interface Reference
Shield ID-NET™
Shield | Network Cable Shield REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -

Main Interface

RS232 RS485/422 Full-Duplex
X TX+
RTS TX-
RX *RX+
CTS *RX-
SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.

CAUTION

Do not connect GND, SGND and REF to different (external) ground
references. GND, SGND and REF are internally connected through filtering
circuitry which can be permanently damaged if subjected to voltage drops

over 0.8 Vdc.




RAPID CONFIGURATION e

STEP 2 — MOUNT AND POSITION THE READER

1. To mount the Matrix 300™, use the mounting brackets to obtain the most suitable
position for the reader. The most common mounting configuration is shown in the figure
below.

d U

% J
(@)

-t

3 g

< <

Figure 2 —Positioning with Mounting Bracket

2. When mounting the Matrix 300™ take into consideration these three ideal label position
angles: Pitch or Skew 10° to 20° and Tilt 0°, although the reader can read a code at any tilt
angle provided the code fits into the Field Of View (FOV).

Tilt Skew

any angle Assure at least 10°
inside FOV

Pitch

Minimize

No Pitch, Tilt or Skew

FOVy

FOVy

Figure 3 — Pitch, Tilt and Skew Angles

3. Refer to the reading diagrams in chp. 6 to determine the distance your reader should be
positioned at.

Rapid Configuration of the Matrix 300™ reader can be made either through

the X-PRESS™ interface (steps 3-4) which requires no PC connection, or

by using the VisiSet™ Setup Wizard (steps 5-6). Select the procedure
NOTE according to your needs.
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STEP 3 - AIM AND AUTOFOCUS THE READER

(Liquid Lens Models only)

Matrix 300™ provides a built-in laser pointer aiming system to aid reader positioning. For
Liquid Lens models the autofocus feature is also incorporated into this function. The aiming
system is accessed through the X-PRESS™ Interface.

1. Power the reader on. During the reader startup (reset or restart phase), all the LEDs blink
for one second. On the reverse side of the reader near the bracket, the “POWER ON”
LED (blue) indicates the reader is correctly powered.

2. Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance for your application. See the Reading Diagrams in chapter 6 for reference.

3. Enter the Aim/Autofocus function by pressing and holding the X-PRESS™ push button
until the Aim LED is on.

4. Release the button to enter the Aim function. The laser pointers turn on, and the
Autofocus procedure begins, see Figure 4. The Aim LED will blink until the procedure is
completed.

Within 3 seconds (before the reader flashes), center one of the larger codes on the
aiming system pointers (the code must not move during this procedure).

The Autofocus procedure ends when the Reading Distance and PPl values are
successfully saved in the reader memory, the Aim LED will stop blinking and Matrix 300™
emits 3 high pitched beeps.

If the Autofocus cannot be reached after a timeout of about 3 (three) minutes Matrix 300™
will exit without saving the parameters to memory, the Aim LED will stop blinking and in this
case Matrix 300™ emits a long low pitched beep.

COATALOGCIC

Figure 4 — X-PRESS™ Interface: Aim/Autofocus Function

You can exit the Aim/Autofocus function at any time by pressing the
X-PRESS™ push button once. After a short delay the autofocus procedure

NOTE is cancelled and the laser pointers turn off.
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STEP 4 — X-PRESS™ CONFIGURATION

Once Matrix 300™ has focused at the correct reading distance, you must configure it for
optimal code reading relative to your application. This configuration can be performed either
through the X-PRESS™ Interface or the VisiSet™ configuration program.

Aim
1.

Enter the Aim function by pressing and holding the
X-PRESS™ push button until the Aim LED is on.

Release the button to enter the Aim function. The
laser pointers turn on.

Select a single code from your application.
Position the code at the center of the FOV
(equidistant from the laser pointers).

The reader may start flashing and try to perform autofocus

however this will have no effect on the application specific
code; it can be ignored.

Exit the Aim function by pressing the X-PRESS™
push button once. After a short delay the Aim
function is cancelled and the laser pointers turn
off.

Setup

4,

Enter the Setup function by pressing and holding
the X-PRESS™ push button until the Setup LED is
on.

Release the button to enter the Setup function.
The Setup LED will blink until the procedure is
completed.

The Setup procedure ends when the Image
Acquisition parameters are successfully saved in
the reader memory, the Setup LED will stop
blinking and Matrix 300™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout
of about 5 (five) seconds Matrix 300™ will exit
without saving the parameters to memory, the
Setup LED will stop blinking and in this case Matrix
300™ emits a long low pitched beep.

Figure 5 — X-PRESS™ Interface: Aim
Function

Figure 6 — X-PRESS™ Interface: Setup
Function




MATRIX 300™ REFERENCE MANUAL

Learn

6. Enter the Learn function by pressing and holding

the X-PRESS™ push button until the Learn LED is
on.

Release the button to enter the Learn function.

The Learn LED will blink until the procedure is

completed.

The Learn procedure ends when the Image
Processing and Decoding parameters are
successfully saved in the reader memory, the
Green Spot is activated, the Learn LED will stop
blinking and Matrix 300™ emits 3 high pitched
beeps'.

If the autolearning cannot be reached after a
timeout of about 3 (three) minutes Matrix 300™ will
exit without saving the parameters to memory, the
Learn LED will stop blinking and in this case Matrix
300™ emits a long low pitched beep.

Figure 7 — X-PRESS™ Interface: Learn
Function

The Grade A Barcode Test Chart cannot be used to set the Code 128
symbology (even though the reader successfully reads the code). Use the
NOTE application specific code if you need to set this symbology.

You can exit the Learn function at any time by pressing the X-PRESS™
push button once. After a short delay the Learn procedure is cancelled.

NOTE

If you have used this procedure to configure Matrix 300™ go to step 7.

NOTE

Reset Reader to Factory Default (Optional)

If it ever becomes necessary to reset the reader to the factory default values, you can
perform this procedure by holding the X-PRESS™ push button pressed while powering up
the reader. You must keep the X-PRESS™ push button pressed until the power up
sequence is completed (several seconds) and all LEDs blink simultaneously 3 times.

All LEDs remain on for about 1 second, then off for one second, the Configuration and
Environmental parameters are reset, and the status LED remains on. If connected through a
CBX500 with display module, the message "Default Set" is shown on the display.

1 . . .
The Learn procedure will not recognize Pharmacode symbologies.

6
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STEP 5 — INSTALLING VISISET™ CONFIGURATION PROGRAM

VisiSet™ is a Datalogic reader configuration tool providing several important advantages:

e Setup Wizard for rapid configuration and new users;

+ Defined configuration directly stored in the reader;

e Communication protocol independent from the physical interface allowing the reader to
be considered as a remote object to be configured and monitored.

To install VisiSet™, turn on the PC that will be used for the configuration, running
Windows 98, 2000/NT, XP, Vista, 7 or 8; then insert the VisiSet™ Mini-DVD, wait for it to
autorun and follow the installation procedure.

This configuration procedure assumes a laptop computer, running VisiSet™, is connected to
the reader's auxiliary port. The reader can also be connected to VisiSet™ through the on-
board Ethernet by following the procedure in chp. 7.

After installing and running the VisiSet™ software program the following window:

T LS Lavedt Decdtredt Dwv (000 Teie ks

Figure 8 - VisiSet™ Opening Window

Set the communication parameters from the "Options” menu. Then select "Connect”, the
following window appears:

I LS Cataet Dcorvet Deves  Coood T 1

MATH HENU

bbb a b Al R S LR 1 FARIN R Y LD AN LA

Figure 9 - VisiSet™ Main Window After Connection
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STEP 6 — CONFIGURATION USING SETUP WIZARD

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader
configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

S Setup Wirard ~ £ Setup Wired

5 = |
| Possenng | Send Dwlauts |

_ Catmgron Mode
2. Colbeoson T Ovnge Dgoose Tave At Gan e Mose!
T e fiwe Orey

Fne Focusieg
Coshas wmage _ Codn Semeg Mode
1 Codw Seftrg R AsiNew Symtckom
== . Faphace Cumwt § noctogm
Destom gt Lowg Optons
e et b PALULITIRSS
e Leeg —— vt ay Mooy
Zatp Favae
Decadng Rends J
ooy Lot (o [ ] L“

Code Cue

Conde Corom

mage Lgurg Gusby

2. Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance for your application. See STEP 2 - Mount and Position the Reader and the
Reading Diagrams in chapter 6 for reference.

3. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. The Setup Wizard now shows four delimiters (red
points) in the acquired images which indicate the region in which the calibration algorithm
is active. Choose one of the larger codes and move either the reader or code to center it.

The code must be aligned across the X-axis reference line at the center of the FOV. See
figure below.

Press the Positioning button again to stop positioning.
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4. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings.

I Calramen Mode
4 % Duarge Expones Teve 2out G (S Modet
L " Ownge fian Onke
Catoeman |
Vo lvage
e e
Rowsom Pt
g AL G bt
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Do n
Oncadrg Nesss
L rtooy Lt Caow [ 3 4
CoseDiua falitestion procedite ia progtess ...
Code Cortm
Len procedute coapleted wring Inage Acguisitien
Setzing 01,
New Daposure Tiae (alwals O
e L eng oy
Tew Gain t 1
R
Ouore

5. Press the "Fine Focusing" button to activate the Focus procedure.

B For Liquid Lens models, the Fine Focusing procedure requires the Grade A
Barcode Test Chart to be used; otherwise the procedure will fail.
CAUTION
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{H Confirmation 3 Sekp Rona =
AutoPecusing Progeess: § ~
This step requires the Grade A Barcode Test
Chartto be used. O _A
The optimal focus will automatically be
determined and setin Acquisition Setting #1.
Do you wantto continue?
X No
Setap Rent
. W..‘:,a?u.‘:u. Progeessr 1%V A
The reader starts the focus procedure and gives
visual feedback in the Setup Wizard window. The KO

Setup Result section of the Setup Wizard window
reports the procedure progress (in percentage).

_r.;?.xt_un Pregeess:

Focus pesceduce ¢
|ocade A Bazcode Teas Chast at & valid Fesding Distesce,

At the end of the procedure the Reading Distance, | | .
PPl and FOV data are reported.

led ' Make sute you ate using the

Now place a single application specific code in front of the reader (at the same reading
distance) and repeat steps 3, and 4. Do not perform step 5 "Fine Focusing".

Select a Code Setting Mode choice and press the "Code Setting" button.

The Setup Result section of the Setup Wizard window shows the code type results.
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o P bl Setup Result
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DOore »
The Grade A Barcode Test Chart cannot be used to set the Code 128
symbology (even though the reader successfully reads the code). Use the
NOTE application specific code if you need to set this symbology.
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8. Select a Saving Options choice and press the "Save" button.

Powsonrg | _SendDutauts_|

C ey mam Veode
7. Caltvason _ ¥ Onarnge Ugoose T Aot Goan e Wose!
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" Crange e Ory
ne Focusing
Codn ey Mode
)

3 Code 5 | " Axd New b petckgy
- :...—ﬁ...:u: - " o 5
— Lowg Optone
O Pt Moy I
T omguaw, Moy,
Cotip Pt

catute coapleted: L code(n) Lomnd, -

Decoding Metdad I Suandand

Checking configuration, , 0K
COMELGUENTIAN Samed LN Pormanent senary

9. Close the Setup Wizard.

If your application has been configured using the VisiSet™ Setup Wizard,
your reader is ready. If necessary you can use VisiSet™ for advanced

NOTE reader configuration.
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STEP 7 - TEST MODE
Use a code suitable to your application to test the reading performance of the system.

1. Enter the Test function by pressing and holding the X-PRESS™ push button until the
Test LED is on.

2. Release the button to enter the Test function.
Once entered, the Bar Graph on the five LEDs is activated and if the reader starts

reading codes the Bar-Graph shows the Good Read Rate. In case of no read condition,
only the STATUS LED is on and blinks.

Figure 10 — X-PRESS™ Interface: Test Function

3. To exit the Test, press the X-PRESS™ push button once.

By default, the Test exits automatically after three minutes.
NOTE

The Bar Graph has the following meaning:

Figure 11 — Test Function Bar Graph

12
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ADVANCED READER CONFIGURATION

For further details on advanced product configuration, refer to the VisiSet™ Help On-Line.
The following are alternative or advanced reader configuration methods:

Advanced Configuration Using VisiSet™

Advanced configuration can be performed through the VisiSet™ program by selecting
Device> Get Configuration From Temporary Memory to open the Parameter Setup window in
off-line mode. Advanced configuration is addressed to expert users being able to complete a
detailed reader configuration. The desired parameters can be defined in the various folders
of the Parameter Setup window and then sent to the reader memory (either Temporary or
Permanent):

I LR et Decoatedt Ddwss Comots Thie 1ee

MATH MEMW

Permanent | lokesactive |

| T Codes Fotel Loden tmagm Py wrwg B
Floadrg Syvtws Lot CE<Gueney | Dosley Deagreetecs
(M s Cotemon | Ogi0 | LEDw hot Fagpaa

Coleeton | Math Code Lad Vet st O wt
DULLETION
Nt (1 Cooes )

Conte Colbew tyw 7 dors D ttet

Coxte Futd Cutbeg. Dastome
o Poad Massage o

Daa Pachon F o

it o ] S g ey Tt

Tratute s Fabd Fome

o

TR G 91 G0 LSRG e ARy L LN AL n

Figure 12 - VisiSet™ Parameter Setup Window

Host Mode Programming

The reader can also be configured from a host computer using the Host Mode programming
procedure, by commands via the serial interface. See the Host Mode Programming file on
the Mini-DVD.

Alternative Layouts

If you need to install an Ethernet network, ID-NET™ network, or Fieldbus network, refer to
the Matrix 300™ Reference Manual.

The reader can also be setup for alternative layouts by reading programming barcodes. See
the "Setup Procedure Using Programming Barcodes" printable from the Mini-DVD.
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2 INTRODUCTION

2.1 PRODUCT DESCRIPTION

Matrix 300™ is a Datalogic industrial compact 2D imager designed and produced to be a
high performance affordable solution for both linear and two-dimensional code reading
applications.

Matrix 300™ uses imaging technology and provides complete reading system functions by
integrating image capturing, decoding and communicating in a single compact and versatile
product.

Matrix 300™ sets a new standard in 2D imager technology offering high performance with
improved reading flexibility thanks to its intrinsic modularity.

Matrix 300™ features excellent reading and verifying performance thanks to 1.3 and 2.0
Mega pixel sensors and smart proprietary decoding libraries.

The modular combination of Mega pixels sensors, powerful lighting and adjustable C-Mount
lenses provide high flexibility in covering application with various requirements.

Innovative X-PRESS™ interface, combined with illuminator laser pointers for aiming,
autofocus and a Good Read Spot, enhance the ease of setup and use.

Rugged construction, IP67 protection and max 50°C operative temperature make the Matrix
300™ the ideal product for industrial applications.

Matrix 300™ has been developed for use in numerous industries like:

Automotive
= DPM (Direct Part Marked) Reading and Verification
= Tires Sorting

Electronics
= Large PCB Board Tracking
= Electronics Product Tracking

Distribution & Retail Industry

= Presentation Scanner

= Small Objects Tracking & Sorting
= Warehouse applications

Medical & Pharmaceutical

= Medical Devices Traceability

*= Pharmaceutical and Medicine Manufacturing
= Chemical & Biomedical Analysis

Food & Beverage
=  Work in Progress Traceability
= Code Quality Control

This technology intrinsically provides omni-directional reading.
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Standard Application Program

A Standard Application Program is factory-loaded onto Matrix 300™. This program controls
code reading, data formatting, serial port and Ethernet interfacing, and many other operating
and control parameters. It is completely user configurable from a Laptop or PC using the
dedicated configuration software program VisiSet™, provided on Mini-DVD with the reader.

There are different programmable operating modes to suit various code reading system
requirements.

Quick, automatic focus, positioning, calibration and code setting of the imager can be
accomplished using the X-PRESS™ button and LEDs on top of the reader without the
necessity of a PC.

The previous functions can also be performed through VisiSet™ through the Setup Wizard.
This tool includes visual feedback from the reader.

VisiSet™ provides a Calibration Tool to verify the exact positioning of the reader and to
maximize its reading performance.

Statistics on the reading performance can also be visualized through a dedicated window in
VisiSet™,

Programmability

If your requirements are not met by the Standard Application Program, Custom Application
Programs can be requested at your local Datalogic distributor.

Some of the main features of this reader are given below:

Excellent Performance

s 1.3 MPixels (SXGA)

e Adjustable focus through Software controlled Liquid Lenses

¢ Powerful Internal Lighting Systems

+ Outstanding decoding capability on 1D, 2D, Stacked, Postal symbologies
s Excellent performance on DPM applications

e Omni-directional reading

e Frame Rate up to 60 frames/sec

e Region Of Interest Windowing for higher frame rate

e Up to 100 readable codes in a single frame

15



° MATRIX 300™ REFERENCE MANUAL

Ease of Setup

Quick installation without PC by using X-PRESS™ interface for easy and intuitive setup
Laser pointers for aiming
Automatic Imager calibration and Code Settings

Calibration Tool to verify exact code positioning in the Field of View and to maximize the
reading performance

Windows-based VisiSet™ software to configure the reader parameters via PC serial or
Ethernet interface

User-defined database of Image Acquisition Settings (parameter sets)

Smart Fast Bracket

Ease of Use

X-PRESS™ interface LEDs provide operational and performance feedback
Green Spot and beeper for immediate Good Read feedback

Different operating modes to suit various application requirements

Multi Image Acquisition Settings for higher reader flexibility

Run Time Self-Tuning for extreme reader flexibility

Image saving and storage with buffering capability

Diagnostic software tools

Flexible Solution

Modular design
Adjustable Liquid lenses

Complete set of Accessories like external lighting systems, light filters, mounting brackets,
connection boxes, cables and photocells

Ethernet Connectivity with TCP/IP socket for reader parameter configuration, data and
image transfer, FTP client, etc.

3 serial communication interfaces (Main, Auxiliary, ID-NET™)

General purpose I/Os

Versatility

16

Excellent reading performance on Direct Part Marked (DPM) symbols

Code Quality Metrics according to ISO/IEC 16022, ISO/IEC 18004, ISO/IEC 15415,
ISO/IEC 15416 and AS9132 and AIM DPM standards.

Match Code option with a user-defined match code database
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Industrial Strength

e Industrial compact 2D reader

¢ Rugged metal construction

e Sealed circular connectors

e |P67 protection class

¢ 50 °C max operating temperature

e Supply voltage ranges from 10 to 30 Vdc
The reader is particularly suitable for industrial environments where protection against harsh
external conditions is required.

The reader is contained in an aluminum housing; with its internal illuminator, lens and
protective cover, the mechanical dimensions are 95 x 54 x 43 mm and it weighs about 238 g.

Electrical connection of Power, Host interfaces and 1/O signals is provided through an M12

(IP67) 17-pin connector (Figure A, 9). A standard M12 D-Coded (IP67) Ethernet connector is
also present (Figure A, 10).

2.2 INDICATORS AND KEYPAD BUTTON

@
202: CN2468

Figure 13 - Indicators

The following LED indicators are located on the reader:

PWR blue LED indicates that the reader is connected to the power supply (Figure 13, 1)
NET yellow LED indicates connection to the on-board Ethernet network (Figure 13, 2)

17
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In normal operating mode the colors and meaning of the five LEDs are illustrated in the
following table:

READY green LED indicates that the reader is ready to operate (Figure 13, 7)

GOOD green LED confirms successful reading (Figure 13, 6)

TRIGGER |yellow LED indicates the status of the reading phase (Figure 13, 5)

COM yellow LED indicates active communication on the main serial port * (Figure 13, 4)
STATUS red LED indicates a NO READ result (Figure 13, 3)

* When connected to a Fieldbus network through the CBX500, the COM LED is always active, even in the
absence of data transmission, because of polling activity on the Fieldbus network.

During the reader startup (reset or restart phase), these five LEDs blink for one second.

In X-PRESS™ Configuration mode the colors and meaning of these five LEDs are described
in par. 2.4.

The keypad button (Figure 13, 8), is software programmable. By default it starts the X-
PRESS™ interface for quick installation without using a PC (see chp. 1).

2.3 ID-NET™

The ID-NET™ network is a built-in high-speed interface dedicated -
for high-speed reader interconnection. ID-NET™ is in addition to
the Main and Auxiliary serial interfaces. HU Z.M-H-

The following network configurations are available:

= ID-NET™ M/S Synchronized: Single station — multiple readers

CBX100

ID NET"

ID-NET™ interface allows local connection of multiple readers reading different sides of the
same target. All readers share a single presence sensor and activate/deactivate
simultaneously.

At the end of each reading phase a single data message is transmitted to the host.

Thanks to ID-NET™, data communication among readers is highly efficient so that an
immediate result will be available.
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= |D-NET™ M/S Multidata: Multiple stations — single reader

CBX100 CBX100

ID NET"

ID-NET™ interface allows connection of readers reading objects placed on independent
conveyors. All readers are typically located far away from each other and they use a
dedicated presence sensor.

At the end of each reading phase, each reader transmits its own data message to the host.
Thanks to ID-NET™, data collection among readers is accomplished at a high speed without
the need of an external multiplexing device. This leads to an overall cost reduction and to a
simple system wiring.

2.3.1 How To Setup/Configure the Reader Network

A complete ID-NET™ reader network can be easily setup through VisiSet™ as follows:

Mounting & Connection

1. Mechanically mount/install all the readers (refer to par. 3.2 and 3.3).
2. Wire ID-NET™ (refer to par. 4.3 or Error! Reference source not found.).

3. Power up the entire system.

Configuration of Slaves

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Slave reader.

2. Launch VisiSet™ and connect to the Slave reader.
3. From the VisiSet™ Device Menu select "Parameter Setup".

4. Set the Role of the Slave reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Set the Slave Address according to the desired value 1-31 from the
Reading System Layout > Device Network Setting > Slave Address parameter. Each
reader must have a different Address on the ID-NET™ Network.
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6.

8.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Slave device is now Configured. Physically connect it to the Master/Slave network. If
using the CBX connection box equipped with a BM100 Backup module, you can perform
Device Backup at the Slave (see par. 2.4 for details).

The Slave device is now Configured. Repeat these steps for each Slave reader in the ID-
NET™ network.

Configuration of Master

1.

20

Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Master reader.

Launch VisiSet™ and connect to the Master reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Master reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

Enable the planned Slave device N from the Reading System Layout >
Expected Slave Device #N > Status parameter and, if desired, set the related
identification string from the Expected Slave Device #N > Device Description parameter.
Repeat this step for all planned Slave devices.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Master device is now Configured. Physically connect it to the Master/Slave network.
If using the CBX connection box equipped with a BM100 Backup module, perform a
Network Backup at the Master (see par. 2.4 for details).

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.
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] ID-NET Status Window

_mré Addiess _»3.32 Status _nsa. Stalus _oass Descripon Sesisl Numbes _v-«l.. _ -~
I Enabled Prevent Mot 200 C10P01554 Get
2 Enabled Presert Matr 300 C10F01548 Get
3 Enabled Present Matix 300 C10P01552 Get
4 Enabled Prezent Matrix 300 C10P01550 Get
5 Enabled Presert Matr 300 C10P01551 Get
6 Enabled Presert Matix 300 C10P01553 Get
7 Enabled Prezent Matrix 300 C10P01549 Get

The reader network is ready.

2.3.2 ID-NET™ Slave Management Through Master

When an ID-NET™ layout has already been configured, it is possible to modify the
configuration of any Slave from VisiSet through the Master.

1. Connect a PC equipped with VisiSet™ to the Main, or Auxiliary interface of the Master

reader.

2. Launch VisiSet™ and connect to the Master reader.

3. From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices

within the ID-NET™ network.

4. Click anywhere in the row of the specific slave in the ID-NET Status Window when its
Current Status is "Present". The Parameter Setup window will be displayed after a time
based on the network speed, with the configuration of the selected slave.

5. From the specific Slave Parameter Setup Window, change any parameter (not in

interactive mode), save the configuration to a file, or load a configuration from a file.

6. Send the modified configuration to the slave.
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(H Parameter Setup Slave#2 _M__m_.w_
File:
_ Send ~ vend [ efaults _ M ANEn _ neraclive _
20 Codes _ 10 Codes _ Postal Codes _ Image Processing _ Mizcelaneous

Reading System Lapout H Microglyph Codes _ CEX Gateway _ Dizplay _ Diagnostics

|
[ ata Collection _ M atch Code _ Symbol Yerfication _ Communication _
_
|

Dperating Modes _ Calibration _ Digital 110 _ LED = And Keppad
OPERATIMG MODE

Operating Mode Phaze Mode

Feading Phaze OMN Eut. Trig. Leading Edge

Acquizition Trigger Confinuaus

MHumber OF Acquizition

Acguizition Trigger Status

Reading Phaze OFF

Image Acquizition Buffer Size

Acquizition Bety

ACQUISITION TRIGGER DEL&Y

Status

Delay Time [#100us)

]
Always Enabled

E«t Trig. Trailing Edge
10

Dizabled

1
Enabled
E50

CAUTION

If a wrong configuration is set or if the Slave Reading System Layout
slave could lose the network connection.

parameters are changed, the
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2.4 EXTERNAL MEMORY BACKUP AND RESTORE THROUGH
VISISET™

The "External Memory Backup" or "External Memory Restore" functions allow performing
Complete Configuration and Environmental parameter storage for network and reading
devices. Backup & Restore can be applied to any reader connected through a device having
External Backup Memory, regardless of the reader's network configuration. Backup &
Restore automatically checks whether a previous backup or configuration is already available
for each device, speeding the procedure up and making it more secure.

These functions are supported by VisiSet™ for all reading devices having sw 6.10 and later
when connected to:

e CBX + BM100 and/or BM2x0 (sw release 2.02.01 and later)

e QL500 (Ethernet TCP/IP) (sw release 2.02.01 and later)

e QLM-Series Gateways (reading device sw release 6.50 and later)

e Before executing a Backup on a BM100 backup module make sure the Write
Protection switch is set to Unlocked.
e |f BM100 and BM2x0 are both installed B&R is automatically performed only on
the BM100 module.
NOTE s BM2x0 can execute B&R only with Network up and running (network cable
connected).
e QL500 can backup up to 10 nodes (Master + 9 slaves).

Backup

To perform a Backup:

1. Select "External Memory Backup" from the VisiSet™ Device menu
2. You will be warned that the previous backup will be overwritten. Confirm by clicking Yes.

mm Confirmation

Start Configuration Backup?

(Old backup will be overwritten)

X No
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The VisiSet™ Main window shows information as the backup procedure is performed and a
message indicating successful completion.

& visiSet _
Fle Edt Coonect Deconnect Device Options Tools Help

MAIN MENU
Device: Matrix 300

M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibe ation Tool
Standard Application Program for Matrix Family Rel. 6.60
| Data Matribx Setup Wizard MACMINS: 00:07:BE:00:99:A2
DHCP disabled.
A. Run Mode IP Address: 172.27.101.1351
Subnet Mask: 235.255.0.0
B. Capture Image Gateway: 172.27.2.254
PNS1: 172,27.0.32
Backing up local device (Master)...
Local device (Master) successfully backed up
Backing up Slave 1...
Slave 1 successfully backed up
£ Dovningd Last bmage Backup module updated!
H. Upload Bitmap image External Memory Backup procedure successfully completed.

C. Decode Last image

D. View Last Image

Q. mage Buffer

3. Button Function Menu

(Connection; B13P00018 on 172.27,101,151 Resder S2atus: OFF LINE MOOE 109 : OFF

Restore

To perform a Restore:

1. Select "External Memory Restore" from the VisiSet™ Device menu

2. You will be warned that the current device configuration(s) will be overwritten. Confirm by
clicking Yes.

mm Confirmation

Start Configuration Restare?

{Current configuration in device will be overwtritten)

X nNo
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The VisiSet™ Main window shows information as the restore procedure is performed and a
message indicating successful completion.

Fie Edt Comnect Dsconnact Dewce Options Tooks Hedp

MAIN MENU

M. Setup Wizard

F. Calitr ation Tool

| Data Matrix Setup Wizard
A. Run Mode

B. Capture image

C. Decode Last kmage

D. View Last knage

E. Download Last Image

H. Upload Bitmap Image

Q.

G oo

3. Button Function Menu

Device: Matrix 300
Model: 412-010
Communication Port: Ethernet

Standard Application Program for Matrix Family Rel, 6.60
MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
Gateway: 172.27.2.25%4
DHS1: 172.27.0,32
Restoring local device (Master),..
Local device (Master) successfully restored
Checking configuration...O0K
Contfiguration saved in Permanent memory!
Local device updated!
Checking for ID-NET Slaves...
Restoring Slave 1...
Slave 1 successfully restored

External Memory Restore procedure successfully completed.

(Connection: B13P0001S o0 172.27,101.151 Reader Status: OFF LINE MODE Log : OFF

Replacement

The External Memory Restore function also provides easy and secure Single Device
Replacement:

1.
2.
3.

Remove the device to be replaced

Connect the new device (make sure the new device has been previously set to default)

Run the Restore procedure by selecting the "External Memory Restore" item (see:

Restore procedure)
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Erase

To Erase any previous Backup:

1. Select "External Memory Erase" from the VisiSet™ Device menu

2. You will be warned that all device configurations in the current backup will be erased.
Confirm by clicking Yes.

mm Confirmation

Any Configuration present in current Backup will be erased

Are you sure you want to proceed?

The VisiSet™ Main window shows a message indicating successful completion.

File Edt Connect Disconnect Dewce Opticns Tooks Hep

MAIN MENU
e: Matrix 300
M. Setup Wizard : : 412-010

Communication Port: Ethernet

F. Calitwr ation Tool

Standard Application Program for Matrix Family Rel, 6.60
J. Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
A Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture kmage Gateway: 172.27.2.254
DNS1: 172.27.0,32
Backup module erased!
External Memory Erase procedure suocessfully completed,

C. Decode Last knage
D. View Last knage

E. Download Last Image
H. Upload Bitmap mage

Q. Image Buffer

3. Button Function Menu

[Connection: B13P0001S on 172.27.101.151 Reader Status: OFF LINE MODE Log : OFF
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List
To see a List of the current Backup:

1. Select "External Memory Read Backup" from the VisiSet™ Device menu.
The VisiSet™ Main window shows a list of devices in the current Backup.

File Edt Connect Disconnect Dewce Opticns Tooks Hep

MAIN MENU
Device: Matrix 300

M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibration Tool
Standard Application Program for Matrix Family Rel, 6.60
J. Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
A Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture Image Gateway: 172.27.2.254
DNS1: 172.27.0.32
List of backup present on External Memory:
MASTER:Matrix 300
SLAVE 1:Matrix 300

C. Decode Last knage

D. View Last inage
E. Download Last Image

H. Upload Bitmap mage

Q. Image Buffer

3. Button Function Menu

(Connection: B13P0001S on 172.27,101.151 Reader Status: OFF LINE MODE Log : OFF

The following is a list of possible error messages displayed on the VisiSet™ main window in
case of an External Memory function failure:

e Module not present: backup module not mounted (BM100) or not ready (QL500,
BM2x0)

¢ Unable to Read Backup State: VisiSet™ is unable to connect to the backup memory

e Backup function not allowed: when device is in X-PRESS™ Menu mode (BM100,
QLM) or is out of memory (QL500)

e Failed! (Device not found): Master is unable to reach the addressed device
e Failed! (Module is write protected): BM100 Write Protection switch is set to Locked
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2.5 X-PRESS™ HUMAN MACHINE INTERFACE

X-PRESS™ is the intuitive Human Machine Interface designed to improve ease of
installation and maintenance.

Status information is clearly presented by means of the five colored LEDs, whereas the
single push button gives immediate access to the following relevant functions:

s Learn to self-detect and auto-configure for reading unknown codes

e Setup to perform Exposure Time and Gain calibration

 Aim/Autofocus to turn on the laser pointers to aid positioning and focusing

e Test with bar graph visualization to check static reading performance

2.5.1 X-PRESS™ Functions

Quick access to the following functions is provided by
an easy procedure using the push button:

1 — Press the button (the Status LED will give a
visual feedback).

2 — Hold the button until the specific function LED is
on (Test, Aim, Setup or Learn).

3 — Release the button to enter the specific function.

Once button is pressed, the cycle of LEDs activation is as follows:

> > >
Release button Release button Release button
to Exit to enter Test Mode to enter Aim/Autofocus Mode

> > = (cycle)
Release button Release button Release button
to enter Setup Mode to enter Learn Mode to Exit
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Test Mode (Function 1)

Once entered, the Bar Graph on the five LEDs is activated and if the imager starts reading
codes the Bar-Graph shows the Good Read Rate. In case of a NO READ condition, only the
Status LED is on and blinks.

The Bar Graph has the following meaning:

To exit the Test Mode, press the X-PRESS™ push button once.

By default, the Test exits automatically after three minutes.

NOTE

Aim/Autofocus (Function 2)

This function causes the laser pointers to turn on. Since the laser pointers are centered on
the FOV they can be used to position the imager on the code. The Aim LED blinks to indicate
this state. After a short delay, this function also performs the Autofocus procedure for Liquid
Lens models.

You can exit the Aim/Autofocus function at any time by pressing the X-PRESS™ push button
once. After a short delay the autofocus procedure is cancelled and the laser pointers turn off.
Setup (Function 3)

Once entered, the imager automatically performs Image Acquisition parameter calibration for
the specific code presented to it.

The Setup LED will blink until the procedure is completed.

The Setup procedure ends when the Image Acquisition parameters are successfully saved in
the reader memory, the Setup LED will stop blinking and Matrix 300™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout of about 5 (five) seconds Matrix 300™ will
exit without saving the parameters to memory, the Setup LED will stop blinking and in this case
Matrix 300™ emits a long low pitched beep.
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Learn (Function 4)

Once entered, the imager starts a procedure to automatically detect and recognize codes
which are presented to it.

The Learn LED will blink until the procedure is completed.

The Learn procedure ends when the Image Processing and Decoding parameters are
successfully saved in the reader memory, the Green Spot is activated, the Learn LED will stop
blinking and Matrix 300™ emits 3 high pitched beeps.

If the autolearning cannot be reached after a timeout of about 3 (three) minutes, Matrix 300™
will exit without saving the parameters to memory, the Learn LED will stop blinking and in this
case Matrix 300™ emits a long low pitched beep.

You can exit the Learn function at any time by pressing the X-PRESS™ push button once.
After a short delay the Learn procedure is cancelled.

2.5.2 Diagnostic Indication

The “STATUS” and “READY” LEDs blink simultaneously while the "GOOD" LED is on to
signal the presence of an error. Diagnostic message transmission on interfaces can be
enabled to provide details about specific error conditions. See the Diagnostic Error
Conditions chart in the Help On Line.

LED STATUS
READY BLINK
GOOD ON to indicate an error
TRIGGER
COM
STATUS BLINK

2.6 MODEL DESCRIPTION

The Matrix 300™ reader is available in different versions according to the following
characteristics:

MATRIX 300 4XX-0XX

Internal ___c3_3mwoﬂ O+m:o:m
1 =Wide Angle Red 0 = Standard
5 = Wide Angle White 1= ESD Safe
7 = Light DPM 2 = ESD Safe + YAG
8 = Multi-Light DPM Cut Filter
Y
Lens Type Input Power
2 = LQL-9 (9 mm Auto Focus) 1 = Standard 10 - 30 Vdc

4 = PoE 48 Vdc
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2.6.1 Lighting System Notes

The following table shows the Matrix 300™ lens/illuminator combinations. For more
information see the Application Note on illuminator selection on the mini-DVD.

Matrix 300 Models Internal llluminators
Model Lens Type LEDs | Type
Matrix 300 412-0xx 8 Red Wide Angle
Matrix 300 452-0xx 8 White Wide Angle
Matrix 300 472-0xx LQL-9MM Software Focus 50 | Red Bright Field DPM (sw configurable chains)
Matrix 300 482-0xx 39 | Red Bright/Blue Dark Field DPM (sw configurable chains)

2.7 ACCESSORIES

The following accessories can be used with the Matrix 300™ reader.

Accessory Description Order No.
Cables
CAB-DS01-S M12-IP67 Cable To CBX or QL (1M) 93A050058
CAB-DS03-S M12-IP67 Cable To CBX or QL (3M) 93A050059
CAB-DS05-S M12-IP67 Cable To CBX or QL (5M) 93A050060
CAB-ETH-MO01 M12-IP67 Ethernet Cable (1M) 93A051346
CAB-ETH-MO03 M12-IP67 Ethernet Cable (3M) 93A051347
CAB-ETH-MO05 M12-IP67 Ethernet Cable (5M) 93A051348
CBL-1480-01 Thin M12/5P Male/Female (1M) 93A050049
CBL-1480-02 Thin M12/5P Male/Female (2M) 93A050050
CBL-1490 Term. Resist. Thin M12/5P/Male 93A050046
CBL-1496 Term. Resist. Thin M12/5P/Female 93A050047
Connectivity
CBX100 Compact Connection Box 93A301067
CBX500 Modular Connection Box 93A301068
BM100 Backup Module for CBX100/500 93ACC1808
BM150 Display Module for CBX500 93ACC1809
Various Fieldbus and Non-Fieldbus Host Interface Modules and All-In-One Connection Box Kits are available
BA100 DIN Rail Adapters 93ACC1821
BA200 Bosch Adapters 93ACC1822
Various M12 Panel Connectors for CBX Connection Boxes are available
BA900 Two Cable Glands Panel 93ACC1847
QL100 Quick Link Slave ID-NET T-Connector 93ACC1860
QL150 Quick Link Slave ID-NET + Service T-Connector 93ACC1868
QL200 Quick Link Slave ID-NET + Power T-Connector 93ACC1861
QL300 Quick Link Master ID-NET - Serial Host Connector 93ACC1862
Quick Link Master ID-NET - Ethernet Host Connector
QLS00 (includes Ethernet/IP explicit messaging) 93ACC1864
QLM500 Quick Link Metal Master ID-NET - EthernNet/IP Gateway 93ACCO0037
QLM600 Quick Link Metal Master ID-NET - Profibus Gateway 93ACCO0033
QLM700 Quick Link Metal Master ID-NET - Profinet /O Gateway 93ACC0038
Various M12 Service Cables and Field Mount Connectors are available for Quick Link Series Connectors
Power Supplies
PG6002 AC/DC Power Supply Unit (US) 93ACC1718
PG6001 AC/DC Power Supply Unit (UK) 93ACC1719
PG6000 AC/DC Power Supply Unit (EU) 93ACC1720
Sensors
MEP-593 Photocell Kit PNP (PH-1) 93ACC1791
MEP-543 Photocell Kit-NPN 93ACC1728
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2.8 APPLICATION EXAMPLES
2.8.1 Document Handling

Matrix 300™ is profitably used in the omnidirectional reading of 2D, stacked, linear and
postal codes for example in automated document handling and mail processing systems
(see Figure 14).

Figure 14 - Address Coded in Data Matrix Symbology for Automated Mail Processing

2.8.2 Deformed or Overprinted Code Reading

Matrix 300™ assures the reading of deformed and / or overprinted codes, even though
damaged or printed on high reflective surfaces (see Figures 17, 18, 19).

Figure 17 - Barcode Printed on Curved Surface Readable by Matrix 300™ in spite of Image Optical
Distortion

32



INTRODUCTION °

2.8.3 Direct Part Marking

Matrix 300™ is also very powerful in reading low-contrast direct part marked codes (see
Figures 20, 21, and 22).

Figure 18 - Dot Matrix Code Directly Marked on Metal Surface by Using Dot Peening Technology

Figure 19 - Dot Peening Marking on Metal Surface with Multi-dot per Code Element

Figure 20 - Directly Marked Dot Matrix Code Characterized by Outstanding Separation Distance between
Adjacent Code Elements

2.8.4 Ink-Jet Printing Technology

Figure 21 - Dot Matrix Code Directly Marked on PCB Copper Pad by Using Ink-Jet Technology
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2.8.5 Laser Marking/Etching Technology

~

_u,_. @ /. K

Figure 22 - Data Matrix Code Directly Marked on PCB Surface by Using Laser Etching Technology

If application codes must be read which are produced by Laser Marking in
real time, use Matrix 300™ models incorporating YAG Filters in order to
CAUTION @void burning the CMOS sensor.
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3

INSTALLATION

3.1 PACKAGE CONTENTS

Verify that the Matrix 300™ reader and all the parts supplied with the equipment are present
and intact when opening the packaging; the list of parts includes:

a

o 0 0 O

Matrix 300™ reader
Quick Reference Guide
Test Charts (2)

Matrix family Mini-DVD

Mounting Kit

e Mounting Screws (4 + 2)
s Washers (2)

e Mounting Brackets (2)

Figure 23 - Package Contents
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3.2 MECHANICAL DIMENSIONS

Matrix 300™ can be installed to operate in different positions. The twelve screw holes (M4 x
5) on the body of the reader are for mechanical fixture (Figure 24).

The diagram below gives the overall dimensions of the reader and may be used for its
installation.

Refer to par. 3.3 for various mounting solutions and correct positioning and chp. 6 for FOV
vs. Reading Distance considerations.

8.1
[0.32)

@ & Q
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43
[1.69]

P

36

20.5

[0.81]

in

36

T ey T[T

Optical Axes

\j M4 Zohl/

36
[1.42]

\
75
[2.95]

375
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Connector block 4/%\

rotates to 90° position

Figure 24 - Overall Dimensions with Connector at 0°
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3.3 MOUNTING AND POSITIONING MATRIX 300™

Using the Matrix 300™ mounting brackets you can obtain rotation on the various axes of the
reader as shown in the diagram below:

o
J
Q
-~
.m
<
N
W

SIATALOGIC

Figure 27 —Positioning with Mounting Bracket
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Matrix 300™ is able to decode code labels at a variety of angles; however significant angular
distortion may degrade reading performance.

When mounting Matrix 300™, take into consideration these ideal label position angles: Pitch
or Skew 10° to 20° and Tilt 0°.

Note: Since Matrix 300™ is omni-directional on the code plane, the Pitch and Skew angles
have the same significance with respect to the code plane. However in some advanced code
reading applications performance can be improved by modifying the Skew angle.

The Pitch, Skew and Tilt angles are represented in Figure 28. Follow the suggestions below
for the best orientation:

Position the reader in order to avoid the direct reflection of the light emitted by the Matrix 300™
reader; it is advised to assure at least 10° for the Skew angle.

Tilt Skew

! Assure at least 10°
any angle

within FOV

Pitch

Minimize

No Pitch, Tilt or Skew

Figure 28 - Code Reading Orientation

In some cases, such as low contrast or low illumination, it can be useful to use a Pitch or
Skew angle = 0°.

The Tilt angle is also represented in Figure 29. Matrix 300™ can read labels with any tilt
angle. Keep in mind however, that since linear barcodes are rectangular, the reader should
be aligned to fit them into the horizontal FOV.
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OK OK

LU %—%ﬁ%

Linear Barcode Reading

2D Code Reading
Figure 29 - Tilt Angle Considerations

See chp. 6 for FOV vs. Reading Distance considerations.
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4 CBXELECTRICAL CONNECTIONS

All Matrix 300™ models can be connected to a CBX connection box through one of the
available CAB-DSxx-S accessory cables. These accessory cables terminate in an M12 17-
pin connector on the Matrix 300™ side and in a 25-pin male D-sub connector on the CBX
side.

We recommend making system connections through one of the CBX connection boxes since
they offer the advantages of easy connection, easy device replacement, opto-isolated
outputs (Outputs 1 and 2), and filtered reference signals.

If you require direct wiring to the reader the connections are the same as
shown in this chapter with the exception of the digital Outputs. Direct wiring

NOTE details are indicated in Appendix A.

The table below gives the pinout of the CBX100/500 terminal block connectors. Use this
pinout when the Matrix 300™ reader is connected by means of the CBX100/500:

CBX100/500 Terminal Block Connectors

Input Power
Vdc Power Supply Input Voltage +
GND Power Supply Input Voltage -
Earth Protection Earth Ground
Inputs
+V Power Source — External Trigger
11A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger
+V Power Source — Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference — Inputs
Outputs
+V Power Source - Outputs
-V Power Reference - Outputs
O1+ Output 1 + opto-isolated and polarity sensitive
01- Output 1 - opto-isolated and polarity sensitive
02+ Output 2 + opto-isolated and polarity sensitive
02- Output 2 - opto-isolated and polarity sensitive
03A Output 3 non opto-isolated (only available on CBX500)
Auxiliary Interface
X Auxiliary Interface TX
RX Auxiliary Interface RX
SGND Auxiliary Interface Reference
ID-NET™
REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -
Shield Network Cable Shield
Main Interface
RS232 RS485/422 Full-Duplex
X TX+
RX *RX+
RTS TX-
CTS *RX-
SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.
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To avoid electromagnetic interference when the reader is connected to a
CBX connection box, verify the jumper positions in the CBX as indicated in

NOTE its Installation Manual.

4.1 POWER SUPPLY

Power requirements and conditions depend on the Matrix 300™ model: Standard or PoE
(Power over Ethernet).

4.1.1 Standard Models

For these models power can be supplied to the reader through the CBX100/500 spring clamp
terminal pins as shown in Figure 30:

Power Supply
VGND

V+ Earth

in Ground

o || | | || s s | o | |

Ol0I000I0I0I0D

vde GND |<&, |REF 1D+ D- & [seno Tx RIS Rx cTs
POWER "% ID-NET %% | MAIN (R)TX+ (RITX- RX+ RX-

Figure 30 - Power Supply Connections
The power must be between 10 and 30 Vdc only.

It is recommended to connect the device CHASSIS to earth ground (Earth) by setting the
appropriate jumper in the CBX connection box. See the CBX Installation Manual for details.
4.1.2 Power over Ethernet (PoE) Models

Power over Ethernet models only support mode A Class 0 power levels and can be powered
by any standard endspan PSE (i.e. PoE switch).

Figure 31 - M12 D-Coded Female Ethernet Network Connector

Power over Ethernet Network Connector Pinout
Pin Name Function
1 TX +/DC- Transmitted data (+) DC power (-)
2 RX +/DC+ Received data (+) DC power (+)
3 TX -/DC- Transmitted data (-) DC power (-)
4 RX -/DC+ Received data (-) DC power (+)
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These models can only supply power to the Digital Outputs directly. They

cannot power any Input devices directly nor a CBX, nor any Input/Output

devices through the CBX. If the CBX or any input devices are used for
CAUTION  these models, they must be powered separately.

See par. 4.7 for further details.

4.2 MAIN SERIAL INTERFACE

Do not connect to the Main Interface spring clamp terminals if using Host

Interface Modules (Fieldbus) with the CBX500.
CAUTION

The signals relative to the following serial interface types are available on the CBX spring
clamp terminal blocks.

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. For more details refer to the
"Communication" folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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4.2.1 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins are used for RS232 interface connection:

CBX100/500 Function
X Transmit Data
RX Receive Data
RTS Request To Send
CTS Clear To Send
SGND Signal Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

USER INTERFACE
SGND RXD TXD

CTS RTS

| | o | | o |

00000

o[l
o[l

REF ID+ ID- | & |SGND TX RTS RX CTS

Vdc  GND 3
ID-NET B\O‘ MAIN (R)TX+ (R)TX- RX+  RX-

POWER

READER SGND TX RX
RTS CTS

Figure 32 — RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START END
OF OF
TRANSMISSION TRANSMISSION
+V
RTS
BV —’ f—
” DATA DATA ”
Y | TRANSMISSION TRANSMISSION |
TX DATA ” [c1 E m ca m ”
-V /, _y I\ I\ J | _y \|
I TRANSMISSION I
” | STOPPED | ”
| . n
ny ENABLED ENABLED P,
-V
IDLE DISABLED IDLE

Figure 33 - RS232 Control Signals

If the RTS/CTS handshaking protocol is enabled, the Matrix 300™ activates the RTS output
to indicate a message is to be transmitted. The receiving unit activates the CTS input to
enable the transmission.
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4.2.2 RSA485/422 Full-Duplex Interface

The RS485/422 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The CBX pinout follows:

CBX100/500 Function
TX+ RS485/422 Transmit Data +
RX+ RS485/422 Receive Data +
TX- RS485/422 Transmit Data -
RX- RS485/422 Receive Data -
SGND Signal Ground

USER INTERFACE

RX485+ TX485+

| | |

o[l
o[l

Vdc GND

REF ID+ ID- aw SGND  TX RTS RX CTS
POWER

ID-NET % | MAIN RITX+ RITX- RX+  RX-

N

00100

READER SGND TX+ RX+
TX- RX-

Figure 34 - RS485/422 Full-duplex Connections

NOTE

For applications that do not use RX signals, do not leave these lines floating
but connect them to SGND as shown below.

USER INTERFACE
RX485+

SGND [ RX485-

| | o | | o

o[l
o[l

Vdc GND

REF ID+ ID- | & |SGND TX RTS RX CTS
POWER

ID-NET \2\0‘ MAIN (R)TX+ (R)TX- RX+ RX- \;

e ee® %0

READER SGND TX+
TX-

Figure 35 - RS485/422 Full-duplex Connections using Only TX Signals
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4.3 ID-NET™ INTERFACE

CBX100/500 Function
Shield Network Cable Shield
ID+ ID-NET™ network +
ID- ID-NET™ network -
REF Network Reference

4.3.1 ID-NET™ Cables

The following instructions are referred to Figure 37, Figure 38 and Figure 39.

« The general cable type specifications are: CATS twisted pair + additional CAT5 twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 - I[EC 62026
UL STYLE 2502 80°C 30V

+ Cable Shield MUST be connected to earth ground ONLY at the Master.
« NEVER use ID-NET™ cable shield as common reference.

« The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
+ For Common Power Connections use only 2 wires (ID+ and ID-).

- DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

- Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

- Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

« Reader's chassis may be connected to earth.
+ Network inside the same building.

Baudrate Table

Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps

Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™ baudrates
allow longer cable lengths. The baudrate is software configurable by

NOTE authorized Datalogic Automation personnel only.
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4.3.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the

Host.
Max ID-NET™ Response Time
240
220
200
180 -
@ 160 forr”
E
o 140 e
£
ﬂ 120 e
2 il P e e
c K =
S 100 ==
o P B d.orl = — —
S 80 I —
o — |
60 I
40
20
0
0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
Number of Nodes
= 500 kbps = = = 250 kbps seeenaee 125 kbps
Figure 36 — ID-NET™ Response Time
CONDITIONS:
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CBX100/500 Main Interface HOST
Reader sl \Iﬁ RS232/RS485
Master e e
. . Shield
o T Teson | [shield "~
: W ID-
ID+
ID-NET™
% Termination mmm_mﬁo_../nwz REF —F
PG-6000 Earth
E—
Vdc *
A
o
&
CBX100/500 Shield o
” - ID- AU_Cmv (1]
Reader || D+ |{White) W 5
Slave o | s rep Hotack) S %
#1 . : \_.m_%_o_ L ® m
° o] T_om::m Shield —— Dlv_ -
o
BN © g
_ ID-NET™ o =
Termination Resistor. O REF — w (1]
PG-6000 Earth %
GND |._|| W
Vdc Q
=
CBX100/500 Shield
— o | (blue)
Reader || D+ | (White)
Slave : W REE (black) \ 4
. 1 shie
pto31) EE e
BN
w ID-NET™ /
Termination Resistor. O
PG-6000 Earth I._u

GND L
Vdc

Figure 37 — ID-NET™ Network Connections with isolated power blocks
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CBX100/500 Main Interface HOST
Reader [T rsz32/rs45
Master e | |ls
. . Shield
_m pe| [ o | [Shietd A
| EN o [
ID+ A4
% ID-NET™
Termination Resistor. O REF
Earth
GND |l_|..|
Vdc *
A
o
@
CBX100/500 Shield o
< < D- (blue) w
Reader R D+ |(White) 8
L] L ] p G
Slave o . REF M. .N
#1 _M . 1 shieta L ® m
. /V ?_cm::m Shield - ﬂ -
Nt DA S o
o | [N s ] R
ID-NET™ A4 a T
Termination Resistor. O REF w (1)
o
Earth X
GND ||_ﬂl w
Vdc Q
=
CBX100/500 Shield
— e b | blue)
Reader m m D+ |(white) v
Slave o REF
. . \_ iel
upto 31) f L] g
4 ID-NET™ ul/
Termination Resistor. O
Earth
GND ||_ﬂl
ﬂ Vdc
POWER
SOURCE
12-24 Vdc

Figure 38 - ID-NET™ Network Connections with Common Power Branch Network
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CBX100/500 Main Interface HOST
Reader ol \Iﬁ RS232/RS485
Master e |l
. ° Shield
. o to "
° =, Earth Shield
| EN N J 1
w_c-zmdg D+ —
Termination Resistor. O REF
Earth
GND ||_||
Vdc *
pol
]
o)
CBX100/500 Shield o
/' oL (blue) o
Reader || D+ | (White) 8 _
[ ] [ ] p G
Slave e |le REF 5 5
#1 . $ 1 shie L ® m
° ol | [fioating] | Shield \q/ - ﬂ -
: | o ) 5
ID-NET™ - D+ /< g =
Termination Resistor. O REF w (1)
Q
Earth *
GND |._|| w
Vdc pm.
=
CBX100/500 Shield B1oe)
e |[e ID- ‘
Reader m m D+ |(White) v
Slave o |le REE
. < \h iel
(up to 31) s e
s [N
w ID-NET™ /ﬁ
Termination Resistor. O
Earth
GND ||_||
_ _ Vdc
POWER
SOURCE
12-24 Vdc

Figure 39 — ID-NET™ Network Connections with Common Power Star Network
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4.3.3 ID-NET™ Network Termination

The network must be properly terminated in the first and last reader of the network. This is
done by setting the ID-NET™ Termination Resistance Switch in the CBX100/500 to ON.

4.4 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The 9-pin female Auxiliary Interface connector inside the CBX is the preferred connector for
device configuration or communication monitoring.

5 1

00000
0000

9 6

Figure 40 - 9-pin female connector

If permanent system wiring is required, the following pins are used to connect the RS232
auxiliary interface:

CBX100/500 Function
RX Auxiliary Interface Receive Data
TX Auxiliary Interface Transmit Data
SGND Auxiliary Interface Reference

USER INTERFACE
RX TX

o || | | —
+#V .V 01+ 01- 02+ 02| +v 12A 2B -V | TX RX
OUTPUTS INPUT2 AUX 3

| | — |
REF 1D+ ID- [ | +v 1A 1B -V [s
ID-NET % TRIGGER

o[l
Q)ll
@)l
@)l
o[l
@)l
o[l

I

o[l
Q)ll
< Ol
o[l
o[l
O[l
o[l
o[l
o[l

Vdc  GND
POWER

Reference

Figure 41 - RS232 Auxiliary Interface Connections

Do not connect the Aux Interface to the CBX spring clamp connectors and
the 9-pin connector simultaneously.
NOTE
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4.5 INPUTS

There are two optocoupled polarity insensitive inputs available on the reader: Input 1
(External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
e reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
¢ match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Vg = 30 Vdc max.
Iin = 10 mA (reader) + 12 mA (CBX) max.

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the default
minimum pulse duration is = 0.5 milliseconds. This value can be increased or decreased
through the software parameter Debounce Filter, see the Digital 1/0 folder in the VisiSet™
Help On Line for further details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

Polarity insensitive inputs assure full functionality even if pins A and B are
exchanged.

NOTE

The connections are indicated in the following diagrams:

CBX100/500 Function
+V Power Source - External Trigger
1A External Trigger A (polarity insensitive)
1B External Trigger B (polarity insensitive)
-V Power Reference - External Trigger

The yellow Trigger LED (Figure 13, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 300™ POWER

N

CAUTION

Power from the Vdc/GND spring clamps is available directly to the Input
Device on the +V/-V spring clamps, and does not pass through the Power
Switch (ON/OFF) inside the CBX. Disconnect the power supply when

working inside the CBX.

PH-1 Photocell (PNP)

(brown)

mmmmmmm%ﬁﬂ O

REF D+ ID- |9 [ +v 1A 1B v seND |,
% TRIGGER AUX

Vdc GND

POWER ID-NET

Figure 42 — PH-1 External Trigger Using Matrix 300™ Power

NPN Photocell

Power to Input
Photocell Signal

Photocell
Reference
o | o | o | | | e | — —
OO0 OIO O
@\&

Vdc  GND REF 1D+ ID- | | v HA 1B -V |SGND
POWER ID-NET % TRIGGER aux |2

Figure 43 - NPN External Trigger Using Matrix 300™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

PNP Photocell

Input
Signal

Pulled down to External
Input Device Reference

| | | | | o | s s s | | | w—|

00000000 e®00

REF D+ ID- &uv +V 1A 1B -V |sGND
%, 2

Vdc GND
% TRIGGER AUX

POWER

ID-NET

Figure 44 - PNP External Trigger Using External Power

NPN Photocell

Pulled up to External
Input Device Power

Input
Signal
| | s | o | o | | s o | | ] — |
& |REF b+ - |8 | v 1A 1B v [sa
5 ; &a\o‘ * TRIGGER >czxu 2

Vdc  GND

POWER ID-NET

Figure 45 - NPN External Trigger Using External Power
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CBX100/500 Function
+V Power Source - Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference - Inputs

INPUT 2 CONNECTIONS USING MATRIX 300™ POWER

Power from the Vdc/GND spring clamps is available directly to the Input

Device on the +V/-V spring clamps, and does not pass through the Power

Switch (ON/OFF) inside the CBX. Disconnect the power supply when
CAUTION  working inside the CBX.

Input Device
Power to
Input Device

Input Input Device
Signal Reference

| | o | | s | s s | — | | w—|

000000 oe)

+V -V 01+ 0O1- 02+ 02-] +Vv 12A 2B -V TX RX
OUTPUTS INPUT2 AUX 3

PNP Input 2 Using MATRIX 300™ Power

Input Device
Power to Input
Input Device Signal

Input Device
Reference

| | o | s s s | — | | m—|

0000008 ee 800

W N 01+ O1- O2r O2|+ 1A 2B Vv | X RX
OUTPUTS INPUT2 ax |3

NPN Input 2 Using MATRIX 300™ Power

INPUT 2 CONNECTIONS USING EXTERNAL POWER

Input Device

Input
Signal

Pulled down to External
Input Device Reference

| | o | | s | | | s | e | | | o | o |

O00000O OO0

+V V. O1+ 0O1- 02+ 02-| +V I2A 2B -V TX RX
OUTPUTS INPUT2 AUX 3

Figure 46 - PNP Input 2 Using External Power
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Input Device
Pulled up to External
Input Device Power

Input
Signal

| | o | | s | | | s | e | | | o | o |

O000OOO OO0

+V -V 01+ 01- 02+ 02-] +v 12A 2B -V TX RX
OUTPUTS

INPUT2 aux |3

Figure 47 - NPN Input 2 Using External Power

INPUT 3 CONNECTIONS (CBX500 Only)

RESERVED

| | o | | s | | s s | o | | | o | o |

O00RIOIOR®IOOI0IO

03A 038 +V 1BA A -V 1348 134B |8y |SGND RTx+ RTX-
OTHER 0 % MAIN 4

Figure 48 - Input 3 Using External Power

D

Do not connect to I13A or 134B signals, they are reserved.
CAUTION
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4.6 OUTPUTS

When Outputs 1 and 2 are connected through the CBX connection box,

they become opto-isolated and polarity sensitive and acquire the electrical

characteristics listed below. To function correctly, they require setting the
CAUTION  output Type configuration parameters to NPN for the respective output in.

Three general purpose outputs are available and their meaning can be defined by the user.
They are typically used either to signal the data collection result or to control an external

lighting system.

CBX100/500 Function

+V Power Source - Outputs

O1+ Output 1 + opto-isolated and polarity sensitive

0O1- Output 1 - opto-isolated and polarity sensitive

02+ Output 2 + opto-isolated and polarity sensitive

02- Output 2 - opto-isolated and polarity sensitive

0O3A Output 3 non opto-isolated (only available on CBX500)
-V Power Reference Outputs

The electrical features of the outputs are the following:

Outputs 1 and 2

Output 3

Vce = 30 Vdc max.

Reverse-Polarity and Short-Circuit Protected

Ice = 40 mA continuous max.; 130 mA pulsed max.

<OC._. A__,O>_U =0 3>v max = 30 Vdc

<0m saturation = 1 <QO max. @ 10 mA

<OC._. A__|0>_U =100 3>v max = 3 Vdc

Pp =90 mW Max. @ 50 °C ambient temp.

lLoap Max = 100 mA

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are

correctly decoded.

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital 1/O folder in the VisiSet™ Help On Line for further details.
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OUTPUT 1 AND 2 CONNECTIONS USING MATRIX 300™ POWER

Device on the +V/-V spring clamps, and does not pass through the Power
Switch (ON/OFF) inside the CBX. Disconnect the power supply when
CAUTION  working inside the CBX.

D Power from the Vdc/GND spring clamps is available directly to the Output

Output 1 Device Output 2 Device
Power to Output Power to Output
Output device Signal Output device Signal
Output device Output device
Reference Reference

o | | o || s | s | | s | |

0000000 000

-V O1+ 0O1- 02+ 02-] +v 12A 2B -V X RX +V -V 01+ 0O1- 02+ 02-] +v 12A 2B -V X RX
OUTPUTS INPUT2 AUX 3 OUTPUTS INPUT2 AUX 3

| | —|

O[l
O[l
Ol

+V

Figure 49 - PNP/Open Emitter Output Using MATRIX 300™ Power

Output 1 Device Output 2 Device
Power to Power to
Output device Output device

Output device
Reference

Output
Signal

Output device
Reference

Output
Signal

* || | | |
+ vV 01+ O1- 02+ 02|+ 12A 2B -V | TX RX
OUTPUTS INPUT2 AUX 3

| o | | s | s | | | e

O|0|0I00OOIO

+V -V O1+ O1- 02+ 02-| +v 12A 2B -V X RX
OUTPUTS INPUT2 AUX 3

o[l
Qlll
o[l

Figure 50 - NPN/Open Collector Output Using MATRIX 300™ Power

OUTPUT 1 AND 2 CONNECTIONS USING EXTERNAL POWER

Output 1 Device Output 2 Device
Pulled up to External Pulled up to External
Output Device Power Output Device Power
Output Output
Signal Signal
o | | — | o | s | s | | | s e | o | o | e | | | [ e e e} e
+V -V 01+ 0O1- 02+ 02-| +V I2A 12B -V X RX +V -V 01+ 0O1- 02+ 02-| +V I2A 12B -V X RX
OUTPUTS INPUT2 AUX 3 OUTPUTS INPUT2 AUX 3

Figure 51 - PNP/Output Open Emitter Using External Power

Output 1 Device Output 2 Device
Output Output
Signal Signal
Pulled down to External Pulled down to External
Output Device Reference Output Device Reference
| —| o || | | s | e s s e | o | o | e | s | | | o | o | o | s | |
+V -V 01+ 0O1- 02+ 02-]| +V 12A 2B -V X RX +V -V 01+ 01- 02+ 02-] +Vv 12A 2B -V X RX
OUTPUTS INPUT2 AUX 3 OUTPUTS INPUT2 AUX 3

Figure 52 - NPN/Output Open Collector Using External Power
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Output 3 is not opto-isolated but can be assigned to the same events. By default it is not
assigned to any event. The CBX500 must be used to connect this output.

OUTPUT 3 CONNECTIONS USING MATRIX 300™ POWER (CBX500 Only)

Power to .
Output Device Qutput Device

Output Output Device
Signal Reference

= | | — | || s | o s | | e
03A 03B +V IBA A -V 134B 134B SGND RTX+ RTX-
OTHER I/0 MAIN 4

.
\w@v

Figure 53 - Output 3 Using Matrix 300™ Power

OUTPUT 3 CONNECTIONS USING EXTERNAL POWER (CBX500 Only)

Output

Signal
External Device
Ground Reference

| | — |  — | | —| | | o | o |

OORIO®RRO000

O3A 038 +V 13A MA vV 134B 134B SGND RTX+ RTX-
OTHER 110 MAIN 4

Figure 54 - Output 3 Using External Power

Do not connect to I13A or 134B signals, they are reserved.
CAUTION
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4.7 ON-BOARD ETHERNET INTERFACE

The on-board Ethernet Interface can be used for TCP/IP communication with a remote or
local host computer by connecting the reader to either a LAN or directly to a host PC. There
is no need to use a crossover adapter since Matrix 300™ incorporates an auto-cross
function.

A CAB-ETH-MOx cable can be used to connect to a LAN.

On the Matrix 300™ Ethernet interface the following communication channels are available:
e Data Socket
e Image Socket
¢ WebSentinel Socket
e Image FTP Client
e HTTP Server
e Ethernet IP
e Modbus TCP

For further details refer to the Ethernet Folder in the VisiSet™ Help On Line and to the
"Matrix Ethernet Service Guide.pdf" document provided as supplementary documentation.

4.8 USER INTERFACE - SERIAL HOST

The following table contains the pinout for standard RS232 PC Host interface. For other user
interface types please refer to their own manual.

RS232 PC-side connections

1 5 1 13

E /.........................\,

6 9 14 25

9-pin male connector .
p 25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS
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5 TYPICAL LAYOUTS

The following typical layouts refer to system hardware configurations. However, they also
require the correct setup of the software configuration parameters. Dotted lines in the figures
refer to optional hardware configurations within the particular layout.

5.1 POINT-TO-POINT

In this layout the data is transmitted to the Host on the main serial interface. The RS232
auxiliary interface can be used for reader configuration by connecting a laptop computer
running VisiSet™. Host Mode programming can be accomplished either through the main
interface or the Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the main interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its

reading zone.
Host
PG6000 lI CBX

CAB-DSxx ()

O , .
@ = SERRRRRARANE | L\RER
_ ﬂm::_:m_

_ﬂ. __________

JHT |®u| ® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
@ Auxiliary Serial Interface (Local Echo) (RS$232)
® External Trigger (for One Shot or Phase Mode)

Matrix 300™

Figure 55 — Serial Interface Point-to-Point Layout
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In this layout the data is transmitted to the Host on the TCP/IP Ethernet interface (CBX500
with BM200/210 Host Interface Module installed). The RS232 auxiliary interface can be used
for reader configuration by connecting a laptop computer running VisiSet™. Host Mode
programming can be accomplished either through the TCP/IP Ethernet interface or the
Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the TCP/IP Ethernet selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Power

® @
CAB-DSxx " G @ T || €BX500

Matrix 300™

I @ BM2x0 TCP/IP Ethernet Interface
ﬂl @ Auxiliary Serial Interface (Local Echo) (RS$232)
[ ] @ ® External Trigger (for One Shot or Phase Mode)

Host

Figure 56 — BM200/210 TCP/IP Ethernet Interface Point-to-Point Layout
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In this layout a single reader functions as a Slave node on a Fieldbus network. The data is
transmitted to the Host through an accessory Fieldbus interface board installed inside the
CBX500 connection box.

Reader configuration can be accomplished through the Auxiliary interface using the VisiSet™
configuration program or Host Mode programming.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the Fieldbus interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

Power

CAB-DSxx

Matrix 300™

@
©

i

ﬂ CBX500
®

@ Fieldbus Interface (Profibus, DevicNet, etc.)
@ Auxiliary Serial Interface (Local Echo) (RS232)

Host

® External Trigger (for One Shot or Phase Mode)

Figure 57 — Fieldbus Interface Point-to-Point Layout
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5.2 ID-NET™ SYNCHRONIZED NETWORK

The ID-NET™ connection is used to collect data from several readers to build a multi-point or
a multi-sided reading system; there can be one master and up to 31 slaves connected
together.

The slave readers are connected together using the ID-NET™ interface. Every slave reader
must have an ID-NET™ address in the range 1-31.

The master reader is also connected to the Host on the RS232/RS485/422 main serial
interface.

For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;
there is a single reading phase and a single message from the master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.

In the Master/Slave Synchronized layout the Master operating mode can only be set to
Phase Mode.

The main, auxiliary, and ID-NET™ interfaces are connected as shown in the following
figures.

Power

Host @® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
,‘7 @ External Trigger
® ID-NET™ (up to 16 devices - practical limit)

Figure 58 — ID-NET™ M/S Synchronized Layout

The Master reader can be connected to the CBX series connection box with the advantage
of the Backup and Restore configuration function (CBX + BM100 module).
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If the Backup and Restore function is not required, then a QL300 or QL500 can be used to
connect the master reader.

CAB-AUX03 CAB-AUX03
ID-NET™ QL150
CBL-1480-xx CBL-1480-xx
Slave Nodes
x
X
3 CBL-1490
S ID-NET
m_ mﬁ F Terminator
o E
{ £ -, - = 4
Master —
The ID-NET network must be terminated through the
PS internal switch of the CBX500 and inserting an ID-NET
_ terminator into the last QL in the network.
POWE! qlllh
CAB-PW-EXT @ Host @ BAB600 ID-NET™ Out
T | @ BA400 Ext. Power
= .
) e ' 3 BA500 Trigger
CBX500 2 \\_| @ BA300 Service
Main - ..,\I.,,v =
CAB-AUXO03 .
Figure 59 - ID-NET™ Synchronized Layout
Matrix 300™ Master with CBX500 + Matrix 300™ Slaves with QL150
CBL-1496 CAB-AUX03 CAB-AUX03
ID-NET
QL300  Terminator ID-NET™

CBL-1480-xx CBL-1480-xx

Slave Nodes

| Master CBL-1490

| ID-NET

_ " Terminator
m.

| I %

| _ The ID-NET network must be terminated inserting an

_ PS _  I— ID-NET terminator into the QL300 (Master) and into the

Power [ last QL in the network.
CAB-PW-EXT

Host

Main Interface

Figure 60 - ID-NET™ Synchronized Layout
Matrix 300™ Master with QL300 + Matrix 300™ Slaves with QL150
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

Power / L

Slave#l [ ® &
: ©
=

CBX500

® BM2x0 TCP/IP Ethernet Interface

s @ External Trigger
| |5= ' Host ® ID-NET™ (up to 16 devices - practical limit)

Figure 61 — ID-NET™ M/S Synchronized Layout with BM200/210 TCP/IP Ethernet Interface to Host

Alternatively, the Master reader can communicate to the Host as a Slave node on a Fieldbus

network. This requires using an accessory Fieldbus interface board installed inside the
CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of each individual
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming. See par. 2.3.1 for details.

Power

@ Fieldbus Interface
@ External Trigger (for One Shot or Phase Mode)
® ID-NET™ (up to 16 devices - practical limit)

Figure 62 — ID-NET™ Fieldbus M/S Synchronized Layout
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5.3 ID-NET™ MULTIDATA NETWORK

For a Master/Slave Multidata layout each reader has its own reading phase independent
from the others; each single message is sent from the master reader to the Host computer.

© ©®

/ /
/L
7/
Master Slave#n
—==r}
— Terminal .
H ==
1
Power
Host ® Main Serial Interface (RS232 or RS485/422 Full-Duplex)

@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)
@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 63 — ID-NET™ M/S Multidata

The auxiliary serial interface of the slave readers can be used in Local Echo
communication mode to control any single reader (visualize collected data)
or to configure it using the VisiSet™ utility.

NOTE The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

Power \\

CBX500

Slave#n _

I
[ g

_|_@ 1

P \_ | Host

@® BM2x0 TCP/IP Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 64 — ID-NET™ M/S Multidata Layout with BM200/210 TCP/IP Ethernet Interface to Host

The auxiliary serial interface of the slave readers can be used in Local Echo
communication mode to control any single reader (visualize collected data)
or to configure it using the VisiSet™ utility.

NOTE The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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Alternatively, the Master reader can communicate to the Host as a Slave node on a Fieldbus
network. This requires using an accessory Fieldbus interface board installed inside the
CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of each individual
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming. See par. 2.3.1 for details.

Power \\\\
7/
Master Slave#1 Slave#n
==
" Terminal “ :
H--[ ==
L 1
@ @ Fieldbus Interface
Host S :
@ Auxiliary Serial Interface (Local Echo) (RS232)
o[o[o[o[o]e[° oo’ ofo o o ® External Trigger (for One Shot or Phase Mode)
E _"_ E _"_ E E E - @ ID-NET™ (up to 32 devices, max network extension of 2000 m)
ojojojojojojo J [J ojo ] [J

Figure 65 — ID-NET™ Fieldbus M/S Multidata
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5.4 PASS-THROUGH

An alternative Pass-Through layout allows the more efficient ID-NET™ network to be used.
This layout is really an ID-NET Master/Slave Multidata layout which also allows each reader
(Master and Slaves) to accept input on the Auxiliary interface, for example to connect a
device such as a hand-held reader for manual code reading capability.

Each Matrix 300™ transmits its own messages plus any messages received by its Auxiliary
interface onto the ID-NET™ interface. The Master passes all messages to the Host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

© ©®

/L
/L
7/

Master

Slave#l

Slave#n

Power

Host

@® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
@ Auxiliary Serial Interface (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™

Figure 66 — Pass-Through On ID-NET™ Layout

The reading device connected to the Host can be connected to a Fieldbus

network using a Host Interface module through a CBX500 connection box.
NOTE
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5.5 ETHERNET CONNECTION

The Ethernet connection is possible in two different layouts. In both layouts, before
proceeding with the connection, it is necessary to configure the reader Ethernet parameters
via VisiSet™, For further details, see the Ethernet Folder in the VisiSet™ Help On Line.

In a Point-to-Point layout the reader is connected to a local host by using a CAB-ETH-MOx

cable. There is no need to use a crossover adapter since Matrix 300™ incorporates an
autocross function.

CAB-ETH-MOx

®© - =

CBX

CAB-DSxx

Matrix 300™ B8

. Z

PG6000

@ Ethernet Interface
@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 67 - Ethernet Point-to-Point Layout
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When using a Local Area Network (LAN), one or more Matrix 300s can be connected to the
network by using CAB-ETH-MOx cables:

Matrix 300™
3
=
I
R -
_ @ _ _
_ O _ _
| | |
X
a
3 _ _ _
° g - a3 4
[l ===
<
O 1 1
_ ! CBX _@
1 1
Power
|
Host
NETWORK 7

/I_‘\ = ,
® Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232) |
3 External Trigger (for One Shot or Phase Mode)

Figure 68 - Ethernet Network Layout

Matrix 300™

CAB-ETH-MOx

Host

PoE Switch

Ethernet Interface

Figure 69 - POE Ethernet Network Layout
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6 READING FEATURES

6.1 FOV CALCULATION

Referring to Figure 70 and the formula below, use the data in the following table to calculate
the FOV for your application.

Viewing Angle | Viewing Angle | Viewing Angle | Min Reading Distance
Model Lens do Horizontal Vertical Diagonal mm
Matrix 300 4x2-0xx LNS-1109 9 mm |14 mm 39.8° 32.3° 49.7° 22

The viewing angle has a tolerance of + 1° depending on the reading distance.

FOV, = 2 _Ha + do) tan EXEH_

where:

FOV, = horizontal, vertical or diagonal FOV

o = horizontal, vertical or diagonal viewing angles.

d = reading distance (from window surface to code surface)

do = reading distance offset (from center of lens to window surface)

—>i0oje d =
]
]
R |
\\\\;ﬁM FOVy
oL
FOV
N plane
Y
Figure 70 — Reading Distance References
Example:

The FOV for a Matrix 300 412-0xx at a reading distance of 200 mm is:

FOVy =2 [(200 mm + 14 mm) tan (39.8°/2)] = 78 mm
FOVy = 2 [(200 mm + 14 mm) tan (32.3°/2)] = 62 mm

The following diagrams are given for typical performance at 25°C using high
quality grade A symbols according to ISO/IEC 15416 (1D code) and
ISO/IEC 15415 (2D code) print quality test specifications. Testing should be

NOTE performed with actual application codes in order to maximize the application
performance.
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6.2 READING DIAGRAMS

¢ The following reading diagrams are to be considered as references and are given for
typical performance at 25°C using high quality grade A symbols: Code 128 (1D code) and
Data Matrix ECC 200 (2D code) from the Test Charts provided with the reader.

e Testing should be performed with the actual Matrix 300™ using application codes in
order to evaluate whether maximizing application performance requires adjustments to
the HW/SW configuration with respect to the Reference Conditions given under each
diagram.

¢ The ratio of the Vertical FOV width with respect to the Horizontal FOV width in the
diagrams is about equal to 0.8; specifically 1024/1280. (i.e. FOVy, = FOVy x 0.8).

e The reading distance ranges are measured from the reading window surface.

e The max theoretical Line Speed values for each diagram can be calculated using the
formula in par. 6.3.

¢ Common software parameter settings for 1D Codes are: Processing Mode=Advanced
Code Setting; Self Tuning=Disabled. For 2D Codes: Processing Mode=Standard; Self
Tuning=Enabled; Self Tuning Mode=Processing Modes Only.

e When defining a HW/SW configuration for the Matrix 300™ for conditions different from
those of the reference diagrams, it is suggested to keep in mind the following rules:

¢ Changes in Exposure Time act directly proportional to the luminosity of the image
and inversely proportional to the maximum code reading movement speed.
Consequently, reducing the Exposure Time by half, reduces the luminosity of the
image by half but doubles the theoretical code reading movement speed.

¢ Changes in Gain act directly proportional to the luminosity of the image.
Increasing the Gain value however, can reduce the quality of the acquired image.

¢ At the center of the field of view, the lighting power of the “RED WIDE” illuminator
is about equal to twice that of the “WHITE WIDE” illuminator, 1.5 times that of the
“MLT-DPM” illuminator, and 2.9 times that of the “LT-DPM” illuminator.

¢ For the two DPM illuminators, the overall lighting power being considered is from
the four Central LED chains.

6.2.1 Pre-Configured .INI Files

Each depth of field (DOF) range shown in the various Reading Diagrams can be obtained by
loading a pre-configured .ini file that already contains the parameter settings necessary to
replicate the reading diagram results.

These .ini files are provided with and can be loaded from the VisiSet™ installation directory
as in the following example:

C:\Program Files\Datalogic\VisiSet2\Std_660\Reading Diagram Configuration Files\412-xxx RED Wide

The names of the .ini files correspond to the specific Reading Diagrams; they indicate the
Code Type, Code Resolution, Reading Distance, and Luminosity variable settings (A or B if
any). These can be directly matched to the relative Reading Diagram to obtain the desired
DOF.
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6.2.2 1D (Linear) Codes

Code 128 0.25 mm (10 mils)

6 150

4 100 -

— - - Global Reading Area

E == Reading Distance =190 mm
1 w Read. Dist.
= Read. Dist.

=300 mm, A
=300mm, B

Horizontal Reading Width

.\\\N

-150 +¥——F—F—7—7———

mm 0 50 100 150 200 250

CONDITIONS:

Reading Distance

Hardware Settings

Code Symbology

Code 128

Code Resolution

0.25 mm (10 mils)

Tilt Angle

45°

Skew Angle

15°

Software Parameters

Reading Distance (mm)

190

300

300

412-xxx RED Wide

A

Exposure Time (us)

130

230

500

Gain

25

25

25

llluminator Lighting Mode

Very High Power Strobed
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Code 128 0.30 mm (12 mils)

200
] — - = Global Reading Area
T = Reading Distance = 190 mm
6 450 1| == Read. Dist. =360 mm, A L.
1| —— Read. Dist. = 360 mm, B =T
4 100 4
..hl -
=) ] \
= 2 50 —
o N -
= 7 -
i) § e
S o 1 1
o 0 ] .I
© b N,
= ] Enci]
o . ;
N2 =50 ~ =
o ] /
H -
4 -100 -
] : _
E i 30
6 -150 A I
-200 ——— T T T
mm 0 50 100 150 200 250 300 350 400 450
in 0 2 4 6 8 10 12 14 16
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.30 mm (12 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 190 360 360
412-xxx RED Wide A B
Exposure Time (us) 150 230 500
Gain 20 25 25

llluminator Lighting Mode

Very High Power Strobed
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Code 128 0.33 mm (13 mils)

8 200

6 150

- Global Reading Area
Reading Distance = 185 mm
Read. Dist. =395 mm, A
Read. Dist. =395 mm, B

4 100

Horizontal Reading Width

-4 -100

-6 -150

o
o
TN ST ST N N NN TN TN TN IS TN TN N Y Y N W S SN IS TN TN TN Y Y Y S TN W N S SN T S (Y TN A S

\

/

-8 -200

=]

50 100

mm
in 0 2 4

CONDITIONS:

LI SO N S N SN B BN L BN N SN N S N S B EN N RN B E R S B B O B B RN R B (N N B B B BN B R B R B B B B
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Hardware Settings

Code Symbology

Code 128

Code Resolution

0.33 mm (13 mils)

Tilt Angle

45°

Skew Angle

15°

Software Parameters

Reading Distance (mm)

185 395

395

412-xxx RED Wide

A

B

Exposure Time (us)

150 300

3300

Gain

25 25

15

llluminator Lighting Mode

Very High Power Strobed

High Power Strobed
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Code 128 0.38 mm (15 mils)

10 250 |
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Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.38 mm (15 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 180 452 452
412-xxx RED Wide A B
Exposure Time (us) 140 320 3300
Gain 25 25 15
llluminator Lighting Mode Very High Power Strobed High Power Strobed
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6.2.3 2D (Bi-dimensional) Codes

Data Matrix 0.13 mm (5 mils)
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1.5 1 w—e Reading Distance = 83 mm 3
| = Reading Distance =92 mm . \\ﬂ
L -
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mm 0 10 20 30 40 50 60 70 80 S0 100 110
in 0 0.5 1 15 2 2.5 3 3.5 4
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.13 mm (5 mils)
Tilt Angle 45°
Skew Angle 20°
Software Parameters
Reading Distance (mm) 75 83 92
412-xxx RED Wide
Exposure Time (us) 60 80 100
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
472-xxx LT-DPM
Exposure Time (us) 175 235 290
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
482-xxx MLT-DPM
Exposure Time (us) 90 120 150
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
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Data Matrix 0.19 mm (7.5 mils)
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Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.19 mm (7.5 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 85 110 145
412-xxx RED Wide
Exposure Time (us) 85 110 150
Gain 12 12 12
llluminator Lighting Mode Very High Power Strobed
472-xxx LT-DPM
Exposure Time (us) 247 310 435
Gain 12 12 12
llluminator Lighting Mode Very High Power Strobed
482-xxx MLT-DPM
Exposure Time (us) 128 165 225
Gain 12 12 12
llluminator Lighting Mode Very High Power Strobed
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Data Matrix 0.25 mm (10 mils)
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Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.25 mm (10 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 100 135 195
412-xxx RED Wide
Exposure Time (us) 100 160 200
Gain 13 13 19
llluminator Lighting Mode Very High Power Strobed
472-xxx LT-DPM
Exposure Time (us) 290 465 500
Gain 13 13 22
llluminator Lighting Mode Very High Power Strobed
482-xxx MLT-DPM
Exposure Time (us) 150 240 300
Gain 13 13 19
llluminator Lighting Mode Very High Power Strobed
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150

Data Matrix 0.38 mm (15 mils)
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Hardware Settings

Code Symbology

Data Matrix ECC 200

Code Resolution

0.38 mm (15 mils)

Tilt Angle

45°

Skew Angle
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Software Parameters

Reading Distance (mm)
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412-xxx RED Wide

Exposure Time (us)

250
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380

Gain

17

22

llluminator Lighting Mode

Very High Power Strobed
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6.3 MAXIMUM LINE SPEED AND EXPOSURE TIME CALCULATIONS

The Exposure Time (or Shutter) parameter defines the time during which the image will be
exposed to the reader sensor to be acquired. This parameter depends heavily on the
environmental conditions (external lighting system, image contrast etc.).

In general, a longer time corresponds to a lighter image but is susceptible to blurring due to
the code movement; a shorter exposure time corresponds to a darker image.

The following considerations must be applied only when the internal lighting
system and 2D codes are used. The Maximum line speed allowed for linear
codes or postal code reading applications heavily depends on the direction

NOTE of symbol movement. When the direction of movement is parallel to the
elements of the code, the maximum speed is greater.

Assuming:
e X: Code Resolution (mm)
e Texp: Exposure Time (s)

e LS: Line Speed (mm/s)

The essential condition to avoid blurring effects between two adjacent elements in a dynamic
reading application is:

LS * Ty < X

The maximum (theoretical) line speed LS can be calculated as follows:
X/ ._-mxn (max) = LS (max)
Example:

A Matrix 300™ using:

Internal Lighting Mode = Very High Power Strobe
Exposure Time (x1 ws) = 100 (100 us)
Code Resolution (X) = 0.254 mm (10 mils)

has a maximum line speed of:

0.254 (mm) / 0.0001 (s) = 2540 mm/s

Likewise, Texp max IS the maximum Exposure Time value that can be used without blurring
for the given application line speed and code resolution. Therefore:

X \ LS (max) = ._|mxu (max)
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Texp (max) @Nd LS max) are represented in the graph below as the curved line for X (code
resolution). Values above the curve result in blurring. In practice, the application values are
somewhere below the theoretical line, (in the green area), due to environmental and other
conditions.
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For example, the maximum target speed in the application is also affected by these
conditions:

e Code/Background Contrast: maximum speed decreases when decreasing image
contrast (poor quality codes, reflective transparent coverings, different supports and
printing techniques).

e Code Resolution: maximum speed increases when decreasing code resolution, (i.e. 2X).
There is a decrement of overlapping effects between two adjacent elements.

+ Tilt Angle: maximum speed decreases when increasing Tilt angle (from 0 to 45 degrees).

Texp miny IS the minimum Exposure Time value obtainable for the specific application. It can
be evaluated in static reading conditions and depends on the Matrix reader hardware
selected for the application (internal lighting system, optical lens, reading distance) and on
any external lighting system. It may also depend on code printing quality, and reader
position.

The Internal Lighting Mode parameter allows setting the operating mode of the internal
lighting system. The possible values are:

e Disabled: the built-in LED array is turned off all the time. This option can be useful if using
an external lighting system;

e Always ON: the built-in LED array is turned on all the time at the lowest power level. This
option is useful if the LED-array blinking (Strobed operating mode) disturbs the operator.

¢ Very High/High-Power Strobed: the built-in LED array is on only during the image
exposure time. Two different lighting levels can be set.

To avoid LED array overheating, for Power Strobed settings, the program

automatically limits the range of allowed values for the Exposure Time

parameter. Therefore, after changes to Internal Lighting Mode, recheck
NOTE Exposure Time.
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7 SOFTWARE CONFIGURATION

Software configuration of your Matrix 300™ for static reading or simple code reading
applications can be accomplished by the Rapid Configuration procedure using the
X-PRESS™ HMI (which requires no external configuration program) or by using the
VisiSet™ Setup Wizard for easy setup. These procedures are described in chapter 1.

For other applications use VisiSet™, connecting to the reader through one of the serial ports.

For Ethernet applications, connections to VisiSet™ can be made directly
through the Ethernet port of the reader, or QL500 or BM2x0 Host Interface
module. See the "Configuration Through Ethernet" page in the VisiSet™

NOTE Help On-Line, or the "Matrix Family Setup Procedure Using Programming
Barcodes" document on the Mini-DVD.

7.1 VISISET™ SYSTEM REQUIREMENTS

To install and run VisiSet™ you should have a Laptop or PC that meets or exceeds the
following:

e Pentium processor

e Windows: 98/2000, NT 4.0, XP, Vista, 7 or 8

¢ 32 MB Ram

e 5 MB free HD space

e one free RS232 serial port with 115 Kbaud (or USB-Serial adapter)

e one Ethernet TCP/IP port

e Video Adapter (1024 x 768) or better using more than 256 colors

7.2 INSTALLING VISISET™

To install VisiSet™, proceed as follows:

1. Turn on the Laptop or PC that will be used for configuration (connected to the Matrix
300™ communication ports).

2. After Windows finishes booting, insert the Mini-DVD provided.
3. Launch VisiSet™ installation by clicking Install.

4. Follow the instructions in the installation procedure.
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7.3 STARTUP

After completing the mechanical and electrical connections to Matrix 300™, you can begin
software configuration as follows:

1. Power on the Matrix 300™ reader. Wait for the reader startup. The system bootstrap
requires a few seconds to be completed. The reader automatically enters Run Mode.

2. Run the VisiSet™ program.

3. Press Connect on the VisiSet™ menu bar. The PC will automatically connect to the
Matrix 300™ reader.

Upon connection, Matrix 300™ exits Run Mode and displays the Main Menu on VisiSet™
with all the commands necessary to monitor your reader's performance. You can select
these commands using the mouse or by pressing the key corresponding to the letter
shown on the button. See Figure 71.

Fle Edt Connect Disconnect Devie Options Tools Help Menu Bar

MAIN MENU
Device: Matrix 300
M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibration Tool
Standard Application Program for Matrix Family Rel. 6.60
]. Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.

A. Run Mode IP Address: 172.27.101.151

Subnet Mask: 255.255.0.0
B. Capture Image Gateway: 172.27.2.254

DNS1: 172.27.0.32

C. Decode Last Image
D. View Last Image

E. Download Last Image
H. Upload Bitmap Image
Q. Image Buffer

3. Button Function Menu

Terminal
Window

Status Bar
Command
Window

(Connection; B13PD0018 on 172.27.101,151 Reader Status: OFF LINE MOOE Log : OFF

Figure 71 - Main Window
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7.3.1 VisiSet™ Options

The Options item from the VisiSet™ menu (see Figure 71) presents a window allowing you

to configure:

— the logging function (Log)

— VisiSet™ window properties (Environment)

— VisiSet™ communication channel (Communication)

’
rmu_.:_qq_ Optiom

Save [t

Log options

Voo tut

 OFF

Defaur Dpen Stase

La | Emdmamont | Communication

Log File Nemo

Delote oid log e
©ON = OFF ~ ON

Log Prnt Leved

= Everghing
* Only Codes

Only Enors

m.c»...:‘%

Save £

nmn VisiSel Options

Figure 72 - Options - Log

Log EmAronment | Communication

Foet & Background

nro._mm.vo.x Change Seckground
Festore Fectory méa..oL
Sove L]

Figure 73 - Options - Environment
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Figure 75 - Options — Communication: Ethernet
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7.4 ETHERNET CONFIGURATION (STATIC IP ADDRESSING)

If you want to connect to VisiSet™ using Ethernet then follow the procedure below.

In order to find the reader using the VisiSet™ Look For Devices On Network tool, the
reader and VisiSet™ must be on the same network (not through a sub-network or

router).

The Factory Default static IP address parameter settings for all Matrix Family readers are:

e |P Address =172.24.24.1
e Subnet Mask = 255.255.0.0
e Gateway Address = 172.24.255.254

1. Before changing the Ethernet network settings
on the PC running VisiSet™, close any open
applications which use network resources (i.e. A
Outlook, or Web browser). I oAy, O 1o P S s o S

the sgropasts I sattinge

Intesnet Protocol (TCPAP) Proper ties

Germes

2. On the Configuration PC, from the Control e 08 ackbing Kby
. . . {#) Use the lok IP addboss
Panel> Zmﬁéo% n.wo::mo:o:m_ right-click on H.:m AR ik 172 .24 . 255 . 254
LAN connection icon and open the properties SRR 255.255.0.0
window. Dk s 172 .24 . 255 . 254

3. Select the Internet Protocol (TCP/IP) item and

i i ® Ue DONS 1eover erser
open the properties window. ® Use the folowng DN addesse

Pretewed DHS server

Abenate DNS yerver

4. Set the IP Address fields as shown in the figure
and click OK to save. Advarced

5. In VisiSet select the Ethernet Communication I
Channel in the Options> Communication
window. Then press the Look For Devices On Network button. The Matrix reader will
appear with its default IP Address in the
list.

Seve

6. Input the IP address from the list in the

IP Address field of the Device Ethernet d e s

Channel Address section of the T & Enenet
VisiSet™  Options> Communication Device Eftermet Channet Addross

window (or double-click on the device in 1P Addess

the list). The IP port number is 51235. PPotNurbae [T FlePPuntumbe [

Then click Save.

Lock Fer Davicas On Metwerk, |

7. Perform a Connect (to device) from
VisiSet™,

?,4.}2. D 1P Address Tp}h Murmder —)

Save Ear
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7.5 CONFIGURATION

Once connected to Matrix 300™ as described in par. 7.3 or 7.4, you can modify the
configuration parameters as follows:

1.

90

Press the Calibration Tool button from the Main Menu. Matrix 300™ will download its
permanent memory configuration parameters with the default values (if it is the first time)
to VisiSet™. The Calibration Tool window will be displayed together with the Parameter
Setup window working in Interactive Mode (see par. 7.5.1 and par. 7.5.3).

Edit the Matrix 300™ configuration parameters according to your application
requirements.

Use the Calibration Tool to fine tune the reading performance. See par. 7.5.3.

Close the Calibration Tool window and disable the Interactive Mode by pressing the
interactive button.

Save the new configuration to the reader permanent memory by pressing the Send
button.

Close the Parameter Setup window and press Disconnect on the VisiSet™ menu bar
(see Figure 71) or launch Run Mode from the VisiSet™ Main menu.

Disconnect exits closing communication between Matrix 300™ and VisiSet™, and
causes Matrix 300™ to enter Run Mode. The disconnected reader serial port is now
available.

Run command does not close communication between Matrix 300™ and VisiSet™,
and causes Matrix 300™ to enter Run Mode. In this case the reader output messages
are displayed on the VisiSet™ terminal and the statistics are displayed in the
Statistics window (Statistics enabled).
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7.5.1 Edit Reader Parameters

The Parameter Setup window displays the configuration parameters grouped in a series of
folders. Each parameter can be modified by selecting a different item from the prescribed list
in the box, or by typing new values directly into the parameter box.

By right clicking the mouse when positioned over the name of a specific Parameter or Group,
a pop-up menu appears allowing you to directly manage that particular parameter or group.

You can View the Selected Value for each parameter.
You can Restore the Default Value of each parameter or of all the parameters of a group.

Get Properties gives information about the parameter in the form of a pop-up hint that
describes the default value and the range/list of valid values.

The Short Help gives information about the parameter in the form of a pop-up hint.

(4 Parameter Setup

File Device Mode
Get _ Send _ Send Defaults _ _ Permanent _ A __‘..mnmon:ﬁ 7
2D Codes _ 1D Codes _ Postal Codes _ Image Processing _ Miscellaneous _
Reading System Layout _ Ethernet _ Fieldbus _ Display _ Diagnostics _
Operating Modes _ Calit— e — LEDs And Keypad _
Data Collection _ Match Parameter Group | Communication |
CODE COLLECTION 7
Number Of Codes / 1
Code Collection Filters \ Disabled
DATA FORMAT 7
Code Field Justification Disabled
Code Field Cutting Disabled
” Parameter : B <M.E Selected Value
Statistics Field Separator Sting Resiolaloiact Yale m_zc_wswﬂdomﬂﬂﬂwﬁﬂz eter
Statistics Field Format | Get Properties (right click)
Symbology ldentifiers | Short Help
STATISTICS
Status Disabled

Figure 76 - Editing Parameters
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Parameters to verify/modify:

U Operating Mode

Sets the parameters which customize the reader operating mode
starting from three main modes:

One Shot: acquires a single image based on the selected value
for the Acquisition Trigger and Acquisition Trigger Delay.

Continuous: continuously acquires images with a rate up to the
maximum allowable frame rate per second for the given sensor
depending on the decoding time and the Region of Interest
settings.

Phase Mode: acquires images during the reading phase
depending on the selected value for the Acquisition Trigger and
Acquisition Trigger Delay. The Reading Phase-ON and Reading
Phase-OFF events mark respectively the beginning and end of
the reading phase.

O Calibration

Calibrates the acquisition parameters to maximize the reading
performance (see par. 7.5.3).

U Communication

Configures the parameters relative to each serial port regarding
the transmission, message formatting and string receiving.
Any change to the VisiSet™ communication port parameters

(baud rate, data bits, etc.) is effective as soon as the reader is
disconnected from VisiSet™.

U Reading System Layout

Allows configuring the device according to the desired layout:
Standalone or ID-NET™

O WebSentinel

Enables the Ethernet WebSentinel Agent for communication with
the Datalogic WebSentinel™ plant array monitor.

U Ethernet

Sets the parameters related to the on board Ethernet interface
and to its communication channels.

O CBX Gateway

Sets the parameters related to the External Host Interface
Module through the CBX500 and to its communication channels.

U Image Processing

Sets the image processing parameters shared by all available
symbologies.

4 1D & 2D, Postal Codes

Sets the characteristics of the code symbologies to be read.

1 Data Collection

Defines the code-collection parameters and the output message
format.

U Digital I/0

Configures the reader input/output parameters.

O Match Code

Allows setting a user-defined code and relative parameters to
which the read code will be compared (matched).

U Miscellaneous

Sets the reader name and the saved image format.

U Symbol Verification

Sets the parameters relative to the various specifications in the
Standards which regulate code validation.

U LEDs And Keypad

Sets the X-PRESS™ LED and Keypad parameters related to their
selected Functions: Beeper, Green Spot, Setup, Positioning, etc.

U Display

Sets the Display language and Layout of the BM150 Display
when using the CBX500 connection box.

O Diagnostics

Enables various diagnostic messages, formatting and actions.
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When all the configuration parameters are set correctly, save them to the Matrix 300™
reader by pressing the Send button. See Figure 76.

For successive configuration of other readers or for backup/archive copies, it is possible to
save the configuration onto your PC by selecting the Save Configuration File option from
the File menu.

From the File menu, you can also Save Configuration As Text File for a human readable
version.

Load Configuration File (available in the File menu) allows you to configure a reader from a
previously saved configuration file (.ini).

7.5.2 Send Configuration Options

The device parameters are divided into two main classes, Configuration and Environmental
which are affected differently by the Send Configuration and Send Default Configuration
commands.

Configuration Parameters regard parameters that are specific to the device. These
parameters are influenced by the Send Configuration and Send Default Configuration
commands, that is, they are overwritten by these commands. The same parameters are
modified by the following "Send Configuration with Options" and "Send Default Configuration
with Options" dialogs from the Device Menu:

5 Parameter Setup

File BeEUEEE Mode
Get Configuration , — ,
(- Tn _ A Interactive _
~——  Send Configuration »
2D/ Send Configuration Yith Options > wzm_ | Miscellaneous |
_”Vm Send Default Configuration 4 U_m_._._ P D_mndow_g “
| Send Default Configuration With Options » TR
Dp LEDs AndKeypad |
OPE|  Select Next Parameter Ctrl+F1
Or Select Previous Parameter Ctrl4+F2
Reading Phase ON Ext. Trig. Leading Edge
Acquisition Trigger Continuous
Reading Phase OFF Ext. Trig. Trailing Edage
Image Acquisition Buffer Size 2
ACQUISITION TRIGGER DELAY 1
Status Disabled
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Environmental Parameters regard the device Identity and Position in a Network (ID-NET™,
Ethernet, Fieldbus) and are not influenced by the "Send Default Configuration" and "Send
Configuration" commands. This allows individual devices to be configured differently without
affecting their recognized position in the network.

The following is a list of the Environmental Parameters:

READING SYSTEM LAYOUT
- Device Network Setting
- Number of Slaves

DEVICE NETWORK SETTINGS

- Topology Role

- ID-NET Slave Address

- Network Baud Rate

- Acquisition Trigger String (available only in Multidata configuration)
- Reading Phase ON String  (available only in Multidata configuration)
- Reading Phase OFF String (available only in Multidata configuration)

- Header String (available only in Slave Multidata configuration)
- Terminator String (available only in Slave Multidata configuration)
- Link Failure String (available only in Master Synchronized configuration)

- Link Failure Timeout (ms)  (available only in Master Synchronized configuration)

EXPECTED SLAVE DEVICES
- Status

- Device Description

- Device Network Name

MAIN PORT
- Communication Protocol

ETHERNET SYSTEM (on board)
- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

- DNS1 Address
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HOST INTERFACE
- Host Interface Type

CBX ETHERNET SYSTEM (CBX with Host Interface Modules)
- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

PROFIBUS
- Node Address

DEVICENET
- Node Address

ETHERNET-IP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

PROFINET 10

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

CANOPEN
- Node Address

CC-LINK
- Node Address

MODBUS TCP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

MISCELLANEOUS
- Reader Name

- User Name

- Line Name
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For device replacement it is necessary to send the previously saved configuration (both
Configuration and Environmental parameters) to the new device. To do this select "Send
Configuration with Options” from the Device Menu and check the Environmental Parameters
checkbox:

mmmmza Options

Do youwant to send current configuration to device ?

~Parameter Selection
[ Canfiguration Parameters

v Environment Parameters:

o Yes _ * Mo

In order to return a device to its absolute default parameters including Environmental
parameters, the following Send Default Configuration with Options" dialog must be used:

(4 Send Defaults Options

Do you want to restore default configuration to device ?

~Parameter Selection
v Canfiquration Parameters

W Environment Parameters:

 Yes _ X Mo

96



SOFTWARE CONFIGURATION e

7.5.3 Calibration

VisiSet™ provides a Calibration Tool to maximize the reading performance by tuning the
acquisition parameters and the time of the delayed triggers.

By selecting the Calibration Tool from the VisiSet™ Main Menu (F), the following window
appears together with the Parameter Setup window:

mm Calibration Tool
Top,Left

[~ Stop Image Acquisition
= (™ Disabled
| (s After Any Capture
=l " OnNo Decode
(" OnDecode

=T

‘ Screen Mode-

e
i

& (¢ Decoded Image
| " Code Position Only
. ¢~ Camera Mode

Arm Trigger _
8510
View Image _
Download Image _
Bottom,Right

Image Acquisition Information

Acquisition Setting: 1 Self Tuning: Disabled
Exposure Time (x10us): 35

Gain: 403

_umoom_su Results -

Symbology: Data Matrix ECC 200 Selected Code: _d =
Code Data: Datalogic 2D Code Reader

Code Center: [X.¥])=[811,613)

Code Drientation: i Quality Index:

Image Lighting Quality-

Exposure Index: | ] Lighting Index:
Underexposed oK Overexposed

-Statistical information on the last 10 samples 1 TRIRR

Figure 77 - Calibration OK

This tool provides a "real-time" image display while Matrix 300™ is reading. It also gives
immediate results on the performance of the installed Matrix 300™ reader.

If Self Tuning is enabled, the Calibration Tool window indicates the region where the
calibration algorithm is performed: it is within the central box delimited by four red dots.

The Parameter Setup window works in Interactive Mode in order to cause each parameter
setting to be immediately effective.
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If you want to save the temporary configuration to permanent memory, you

must first close the Calibration Tool window. Then, you must disable the

Interactive Mode and select the Permanent Memory option from the Send
NOTE Configuration item in the Device menu.

The following examples show some of the typical conditions occurring during the installation:

Under-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. increase the Exposure Time
2. increase the Gain

In general, a longer exposure time corresponds to a lighter image but is
susceptible to blurring due to code movement. Exposure time is also limited
by the Internal Lighting mode parameter. Longer esposure times can be
set if the power strobe level is lowered.

NOTE High gain settings may produce a grainy image that may affect the
decoding process.
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Figure 78 - Example Under Exposure: Too Dark
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Over-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. decrease the Gain
2. decrease the Exposure Time
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Chog Image bcgmdun Fie Mada i
* Disabied - ——
© Mwt ey Catan G _ 3 enid _ Send Defuill _ ' Desmanent _ :li!..xi_u
£ On Mo Decode
£ OnDocode 20 Codes | 1D Codes | PostalCodes | Image Processng | Miscefonnous |
S Gcamen Mode DataColecton | MakhCode | SymbolVerfcaon |  Commuricason
.................. A % Decoded inage feadng System Lapor | Dbt | Fiskbus | Display | Dispoosscs
0" Code Posten Orly Dgweatrg Modme Calibuation D0 | LEDe At Kmgpind |
" Coment Mode IMAGE ALTILISITION SETTING 1
Statue Frabled
Sef Tuning Disabled
Irternal Lightargg Mode Vexy HighePoves Stiobed
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Figure 79 - Example Over Exposure: Too Light

99



e MATRIX 300™ REFERENCE MANUAL

Moving code out of the Field of View:

To correct this result and have the code completely visible in F.O.V., it is possible to follow
one or both the procedures listed below:

e reposition the reader
e use the Acquisition Trigger Delay by tuning the Delay Time (x100us)

Calir S 55 parameter Setup - 3
TopLon S e Acqaubur Fir Moda
# Disabied - - —m e -
& M Ay Caman Gt _ .;_._; Send Deluull _ ; Vesmanent _ _4. Intesactive H
" On Mo Decode
£ OnDyouda 20 Codes | 1D Codes | PostalCodes | Image Processng | Miscefanoous |
Seswen Mode DataColection | MakchCode | Symbol Ve | Commuriceson
......................... % Decoded inage feadng System Lapowx | Dbt | Fieldbus | Display | Dispossics
G cx Robaoesc0taan Sesteistoniabeanst i ~ Code Postien Orly gt Modme Calbiation D0 | LED=AndKngpnd |
¢ Comers Mode IMAGE ACTIUISITION SETTING 1
_ Status Frabled
_ Self Tuning Disabled
Seiernial Lighting Mode Vexy High-Poves Stobed
Bamon gt |.._ Evpoare Tare [¥1 0] n
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Figure 80 - Example out of FOV
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7.5.4 Multi Image Acquisition Settings

When controlled variable conditions occur in the application, Multiple Image Acquisition
Settings (up to 10), can be defined to create a database of parameter groups that handle
each specific application condition. This database of pre-defined settings functions cyclically
and therefore automatically improves system flexibility and readiness.

For example, an application may have two stable but different lighting conditions which
require different lighting options. One Image Acquisition Setting could enable and use the
internal illuminator and a second setting could enable and use an external lighting system.
These two groups will be used cyclically on each acquisition in order to automatically capture
the correctly lighted image.

Image Acquisition Settings are found in the VisiSet™ Calibration parameter setup menu.
By selecting a different number and enabling its Status you can define the parameters for a
new group.

7.5.5 Multi Image Acquisition Settings to Extend DOF

A useful case for Multiple Image Acquisition Settings is to extend the reader's depth of field
(DOF). Some applications may require reading at more than one discrete reading distance or
an extended range of reading distances.

Example:

Read a 15 mil Data Matrix ECC 200 code covering a range from 100 to 300 mm (see 15 mil
reading diagram). The reading distance range is too long to be covered by a single
acquisition setting, so two acquisition settings could be used in which the first has a reading
distance of 100 mm and the second has a Reading Distance of 300 mm. When both are
enabled, the reader cycles through the two settings effectively producing the extended DOF.

Cycling through Image Acquisition Settings that require changing the
Reading Distance parameter drastically reduces the frame rate due to the
liquid lens refocusing delay as well as by the number of settings
simultaneously enabled. Therefore this may not be the best solution for high

NOTE speed applications. For high speed applications it is best to use multiple
readers set to different reading distances.

Since many factors and parameters contribute to maximizing the reading process, it is
suggested to use the VisiSet™ Standard Setup Wizard to set the different acquisitions
settings.

Multi Image Acquisition Settings Procedure using Standard Setup Wizard:

1. Using the Standard Setup Wizard set the first acquisition setting (default) for the 100 mm
Reading Distance. Save the setting to Permanent Memory.

2. Through the Calibration Tool (Interactive Mode):
a. Set Calibration>Image Acquisition Setting 1 - Status to Disable
b. Set Calibration>Image Acquisition Setting 2 - Status to Enable
c. Set LEDs And Keypad>Autolearning Setup>Image Acquisition Setting to 2
d. Close the Calibration Tool
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3. Using the Standard Setup Wizard set the second acquisition setting for the 300 mm
Reading Distance. Save the setting to Permanent Memory.

4. Through the Calibration Tool (Interactive Mode):
a. Set Calibration>Image Acquisition Setting 1 and 2 - Status to Enable
b. Verify that the reader decodes at both distances then Close the Calibration Tool
c. Send Configuration to Permanent Memory

7.5.6 Run Time Self Tuning (RTST)

Run Time Self-Tuning (RTST) increases Matrix’s flexibility in the presence of uncontrolled
variable conditions (lighting, code contrast, etc.) by automatically adjusting its acquisition
parameters.

Self Tuning Calibration

In the Calibration parameter setup menu, the Self Tuning parameters manage the Image
Acquisition Setting parameters dynamically. Self Tuning provides automatic adjustment in
run time of different acquisition parameters (Exposure Time and/or Gain) for each captured
image based on calculations performed on previous acquisitions. These dynamic settings will
be used instead of the static settings saved in memory.

TR\ AL
Bl "
From fo
Not Readable Readable

For more details see the Matrix 300™ Help On-Line.

Self Tuning Image Processing

In the Image Processing parameter setup menu, the Self Tuning parameters manage the
Image Processing and Symbology related parameters. They perform different processing
attempts on the same captured image according to the selected Self Tuning Mode parameter
value: (Symbologies Only, Processing Modes Only, Decoding Methods Only, Code Contrast
Levels Only, Image Mirroring Only, or General Purpose).

For more details see the Matrix 300™ Help On-Line.
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7.5.7 Region Of Interest Windowing

In order to satisfy very high throughput applications, higher frame rates can be achieved
using the powerful Region Of Interest Windowing parameters in the Calibration parameter
setup menu.

Region Of Interest Windowing allows defining a region or window within the reader FOV.
The Top, Bottom, Left and Right parameters allow to precisely define the image window to
be processed, visualized and saved.

In all Matrix 300™ models the frame rate is dependent on the number of lines (or rows) in the
defined window.

The smaller the window, the lower the frame period and consequently the higher the frame
rate. In general the Image Processing time can be reduced by reducing the window
dimensions.
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7.5.8 Direct Part Marking Applications
Decoding Method: Direct Marking

For Data Matrix codes the Decoding Method parameter selects the decoding algorithm
according to the printing/marking technique used to create the symbol and on the overall
printing/marking quality. The Direct Marking selection improves the decode rate for low
quality Direct Part Mark codes and in general for Direct Part Mark codes with dot peening
type module shapes.

i
iy

- = 4 :

<<mm:mo_ out wsa Axial Dot Peening On

Distortion Scratched Surface

Low Contrast
Problem

Background Marked On Curved _Axial
Problems Shiny Surface distortion

Half moon effects Shiny surface
noisy background

noisy background

All the previous examples are successfully read selecting the Direct Marking Decoding
Method.
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Image Filter

Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (ex. Direct part mark codes).

A different filter can be applied to each Image Acquisition Setting.

The Erode Filter enlarges the image dark zones to increase readability

el o O
Mty 23 St 1.0 s
higa o P deass™
43 %
PR TR - o e
1dit e et iTis 4 e
20320 1390344
3
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.
.
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.

Shai.
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Before - No Read After - Readable

Erode

The Dilate Filter enlarges the image white zones to increase readability.

Before - No Read After - Readable
Dilate

The Close filter eliminates dark areas (defects) in the white zones of the image.

Before - No Read After - Readable
Close
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The Open filter eliminates white areas (defects) in the dark zones of the image.

Before - No Read After - Readable
Open

The Contrast Stretching filter maximizes image contrast.

SWN

Before - No Read After - Readable
Contrast Stretching
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The Histogram Equalization filter makes the gray level distribution uniform.

Before - No Read

Histogram Equalization

The Smoothing filter deletes small (insignificant) details in the center of the image.

Before - No Read After - Readable
Smoothing

The Sharpening filter improves out of focus images.

Before - No Read After - Readable
Sharpening
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The Deblurring filter improves blurred images.

Before - No Read After - Readable
Deblurring

The Black Enhancement filter produces a nonlinear increase in the black level for light
images.

Before - No Read After - Readable
Black Enhancement

The White Enhancement filter produces a nonlinear increase in the white level for dark
images.

Before - No Read After - Readable
White Enhancement
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7.6 IMAGE CAPTURE AND DECODING

By using the Capture Image and Decode Last Image functions from the VisiSet™ Main
menu, you can get information about the image decodable codes in terms of Symbology,
encoded Data, Position and Orientation, Decode Time and Code Quality Assessment Metrics.
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Sessssssnnananes Duage FPrecesning cespleted (81)

Connwction: COMODEID on 172 Faacder Shatus: OFF LINE MOCK e

Figure 81 - Capture and Decoding Functions

7.7 STATISTICS

Statistics on the reading performance can be viewed by enabling the Statistics parameter
and selecting the View Statistics item in the File menu. One of three different windows
appears depending on the operating mode.

Refer to the VisiSet™ Help On Line for more details.

w
o Statistics

Total S amples

Acquesiion Counter 1000

LComglote Raad Conrdee 10

Complate Resds (%) 100,00

Lazt Samples
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Comolste Fesds (%) 100.00

Reading Peslarmance

Mean Decodeg Tre (ma) 2

Max Decodng Time fme} =

Frome Robe fmages/s) 1#

Last Docoded Code

Smbologr Digta Mawin ECC 200

Code Dala Datadoge 20 Code Hoode
Reset | Closn

Figure 82 - Code Statistics
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8 MAINTENANCE

8.1 CLEANING

Clean the reading window (see Figure A, 1) periodically for continued correct operation of the
reader.

Dust, dirt, etc. on the window may alter the reading performance.
Repeat the operation frequently in particularly dirty environments.

Use soft material and alcohol to clean the window and avoid any abrasive substances.
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9 TROUBLESHOOTING

9.1 GENERAL GUIDELINES

e When wiring the device, pay careful attention to the signal name (acronym) on the
CBX100/500 spring clamp connectors (chp. 4). If you are connecting directly to the Matrix
300™ M16 19-pin connector pay attention to the pin number of the signals (chp. Error!
eference source not found.).

« If you need information about a certain reader parameter you can refer to the VisiSet™
program help files. Either connect the device and select the parameter you're interested in
by pressing the F1 key, or select Help>Paramters Help from the command menu.

« If you're unable to fix the problem and you're going to contact your local Datalogic office or
Datalogic Partner or ARC, we suggest providing (if possible): Application Program version,
Parameter Configuration file, Serial Number and Order Number of your reader. You can
get this information while VisiSet™ is connected to the reader: the Application Program
version is shown in the Terminal Window; the Parameter Configuration can be saved to an
.ini file applying the File>Save Configuration File command in the Parameter Setup
window; Serial Number and Order Number can be obtained by applying the respective
command in the Tools menu.

TROUBLESHOOTING GUIDE

Problem Suggestion

Power ON: ¢ |Is power connected?

the “POWER” LED is not lit. s If using a power adapter (like PG6000), is it connected
to wall outlet?

e If using rail power, does rail have power?

¢ If using CBX, does it have power (check switch and
LED)?

e Check if you are referring to the M16 19-pin connector
or to the CBX spring clamp connectors.

¢ Measure Voltage either at pin A and pin L (for 19-pin
connector) or at spring clamp Vdc and GND (for CBX).

One Shot or Phase Mode |« Check if you are referring to the 19-pin connector or to

using the Input 1 (External
Trigger) or Input 2:
the "TRIGGER” LED is not
blinking while the External
Trigger is switching.

the CBX spring clamp connectors.

Is the sensor connected to the Input 1 or Input 2?

Is power supplied to the photo sensor?

For NPN configuration, is power supplied to one of the
two 11 or 12 signals (A or B)?

For PNP configuration, is one of the two I1 or |2 signals
grounded (A or B)?

Are the photo sensor LEDS (if any) working correctly?
Is the sensor/reflector system aligned (if present)?

In the Digital 1/O folder check the EXTERNAL
TRIGGER or INPUT 2\Debounce Filter parameter
setting.

In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.
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TROUBLESHOOTING GUIDE

correctly blinking but no image
is displayed in VisiSet™
Calibration Tool window.

Problem Suggestion
One Shot or Phase Mode |« In the Operating Mode folder check the settings for
using serial trigger source: Reading Phase-ON, Acquisition Trigger and
the "TRIGGER” LED is not Reading Phase-OFF parameters.
blinking. ¢ Are the COM port parameters (Baud Rate, Parity, Data
Bits, Stop Bits, Handshake) correctly assigned?
s In the communication folder, check the settings of
Reading Phase-ON String, Acquisition Trigger
String and Reading Phase-OFF String parameters.
¢ |s the serial trigger source correctly connected?
Phase Mode: s |s the Phase frequency lower than the maximum frame
the "TRIGGER" LED s rate?

Continuous Mode:

Verify the correct software configuration settings.

correctly blinking but no result
is transmitted by the reader at
the end of the reading phase
collection.

the "TRIGGER” LED is not

blinking.

Any Operating Mode: « In the Data Collection folder check the settings for the
the "TRIGGER” LED is CODE COLLECTION, DATA FORMAT and

STATISTICS parameter groups.

Image not clear:

verify the Focus procedure

the reader always transmits
the No Read Message

Image focused but not |« verify the Calibrate Image Density prodcedure.
decoded:
Reading: + Run the Rapid Configuration procedure in chapter 1.

Position the reader as described in par. 3.3 and through

the VisiSet™ Calibration Tool:

— Tune the ACQUISITION TRIGGER DELAY, if the
moving code is out of the reader field of view;

— Set the Continuous Operating Mode if no external
trigger source is available;

— Tune the IMAGE ACQUISITION SETTING to
improve the code image quality;
— Check the parameter setting in Decoding,

2D Codes, 1D Codes, and Postal Codes folders;
— View the full resolution code image to check the
printing or marking quality.

Communication:
reader is not transmitting
anything to the host.

Is the serial cable wiring correct?

If using CBX, be sure the RS485/422 termination switch
is OFF.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Digital I/O folder, "COM" LED can be
configured to indicate MAIN COM port TX or MAIN
COM port RX.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

Communication:

data transferred to the host
are incorrect, corrupted or
incomplete.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Communication folder check the settings of
Header and Terminator String parameters.

In VisiSet™ Data Collection folder, check the settings of
DATA FORMAT parameter group.

How do | obtain my reader
Serial Number?

The reader Serial Number consists of 9 characters: one
letter, 2 numbers, another letter followed by 5 numbers.
The reader Serial Number is printed on a label that is
affixed on the bottom case near the reading window.
The Serial Number can also be obtained by selecting
Tools/Get Reader Serial Number from the command
menu in VisiSet™. A dedicated window will appear.

How do | obtain my reader
Order Number?

The reader Order Number consists of 9 numbers.

The reader Order Number can be obtained by selecting
the Tools/Get Reader Order Number from the command
menu in VisiSet™. A dedicated window will appear.
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10 TECHNICAL FEATURES

ELECTRICAL FEATURES
Power 4xx-01x models 4xx-04x models
Supply Voltage 10 to 30 Vdc PoE Device 48 Vdc
Consumption 0.7t0 0.2 A 13 W max.
Communication Interfaces
Main
- RS232 2400 to 115200 bit/s
- RS485/422 full-duplex 2400 to 115200 bit/s
Auxiliary - RS232 2400 to 115200 bit/s
ID-NET™ Up to 1Mbaud
Ethernet 10/100 Mbit/s
Inputs
Input 1(External Trigger) and Input 2 Opto-coupled and polarity insensitive; see note for POE models
Max. Voltage 30 Vdc
Max. Input Current 10 mA
Outputs *
Output 1,2 and 3 NPN or PNP short circuit protected; see note for POE models
Vout (lload = 0 mA) Max. 30 Vdc
Vout (lload = 100 mA) Max. 3 Vdc
lload Max 100 mA
OPTICAL FEATURES
Image Sensor CMOS sensor with Global Shutter
Image Format SXGA (1280x1024) pixels
Frame Rate 60 frames/sec.
Pitch + 35°
Tilt 0° - 360°
LED Safety to EN 62471
Laser Safety (pointers) IEC60825-1 2007
Lens 4x2-0xx models
Focal Length 9 mm
Focus Control via software
Lighting System Internal llluminator
Aiming System Laser Pointers
ENVIRONMENTAL FEATURES
Operating Temperature 0to 50 °C (32 to 122 °F) **
Storage Temperature -20 to 70 °C (-4 to 158 °F)
Max. Humidity 90% non condensing
Vibration Resistance 14 mm @ 2to 10 Hz; 1.5 mm @ 13 to 55 Hz;
EN 60068-2-6 2 g @ 70 to 200 Hz; 2 hours on each axis
Bump Resistance 30g; 6 ms;
EN 60068-2-29 5000 shocks on each axis
Shock Resistance 30g; 11 ms;
EN 60068-2-27 3 shocks on each axis
Protection Class IP65/IP67 ***
EN 60529
PHYSICAL FEATURES Connector position 0° Connector position 90°
Dimensions 95 x54 x43 mm (3.7x2.1x1.7in.) | 75x54 x62 mm (3.0x 2.1 x2.41in.)
Weight about 238 g. (8.4 0z.)
Material Aluminium

* when connected to the CBX connection boxes the electrical features for Output 1 and 2 become the following:
Vce = 30 Vdc max.; Ice = 40 mA continuous max.; 130 mA pulsed max.; VcE saturation = 1 Vdc max. @ 10 mA,;
Pp =90 mW Max. @ 50 °C ambient temp.

** high ambient temperature applications should use metal mounting bracket for heat dissipation

*** when correctly connected to IP67 cables with seals.
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SOFTWARE FEATURES

Readable Code Symbologies

1-D and stacked

PDF417 Standard and Micro PDF417
Code 128 (GS1-128)

Code 39 (Standard and Full ASCII)
Code 32

MSI

Standard 2 of 5

e Matrix 2 of 5

¢ Interleaved 2 of 5

e Codabar

e Code 93

e Pharmacode

e EAN-8/13 - UPC-A/E
(including Addon 2 and Addon 5)

s GS1 DataBar Family
s Composite Symbologies

2-D POSTAL
e Data Matrix ECC 200 e Australia Post
(Standard, GS1 and Direct Marking) | Royal Mail 4 State Customer
e QR Code * Kix Code
(Standard and Direct Marking) o Japan Post
* Micro QR Code e PLANET
« MAXICODE ¢ POSTNET
e Aztec Code * POSTNET (+BB)
« Intelligent Mail
¢ Swedish Post

Operating Mode

ONE SHoT, CONTINUOUS, PHASE MODE

Configuration Methods

X-PRESS™ Human Machine Interface
Windows-based SW (VisiSet™) via serial or Ethernet link
Serial Host Mode Programming sequences

Parameter Storage

Permanent memory (Flash)

CODE QUALITY METRICS

Standard

Supported Symbologies

ISO/IEC 16022
ISO/IEC 18004
ISO/IEC 15415
ISO/IEC 15416

AS9132A
AIM DPM

Data Matrix ECC 200
QR Code
Data Matrix ECC 200, QR Code

Code 128, Code 39, Interleaved 2 of 5, Codabar, Code 93, EAN-8/13,
UPC-A/E

Data Matrix ECC 200
Data Matrix ECC 200, QR Code

USER INTERFACE

LED Indicators

Power, Ready, Good; Trigger; Com, Status, (Ethernet Network); Good
Read (Green Spot), No Read (Red Spot)

Keypad Button

Configurable via VisiSet™

Beeper

Configurable via VisiSet™
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A ALTERNATIVE CONNECTIONS

The connector pinouts and notes given in this appendix are for custom cabling applications.

POWER, COM AND I/O CONNECTOR

The Matrix 300™ reader is equipped with an M12 17-pin male connector for connection to
the power supply, serial interfaces and input/output signals. The details of the connector pins
are indicated in the following table:

12 2 3 13
1" 4

10 14
16 6

7 17
mAm

Figure 83 —M12 17-pin male COM, I/O and Power Connector

Power, COM and I/O Connector Pinout
Pin Name Function
1 Vdc Power supply input voltage +
2 GND Power supply input voltage -
Connector CHASSIS Oo::woﬁoq case provides electrical connection to the
case chassis
6 1A External Trigger A (polarity insensitive)
5 1B External Trigger B (polarity insensitive)
13 I2A Input 2 A (polarity insensitive)
3 I2B Input 2 B (polarity insensitive)
9 01 Output 1 (NPN or PNP short circuit protected
8 02 Output 2 and software programmable)
16 03 Output 3 brog
14 RX Auxiliary RS232 RX
4 X Auxiliary RS232 TX
7 ID+ ID-NET™ network +
15 ID- ID-NET™ network -
Pin Name RS232 RS485/422 Full-Duplex
17 MAIN X TX+
11 INTERFACE RX *RX+
12 (SwW RTS TX-
10 SELECTABLE) CTS *RX-

* Do not leave floating, see par. 4.2.2 for connection details.

In order to meet EMC requirements:

e connect the reader chassis to the plant earth ground by means of a flat copper braid
shorter than 100 mm;

e connect your cable shield to the locking ring nut of the connector.
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ALTERNATIVE CONNECTIONS e

ON-BOARD ETHERNET CONNECTOR

A Standard M12 D-Coded female connector is provided for the on-board Ethernet
connection. This interface is IEEE 802.3 10 BaseT and IEEE 802.3u 100 BaseTx compliant.

Figure 84 - M12 D-Coded Female Ethernet Network Connector

On-Board Ethernet Network Connector Pinout
Pin Name Function
1 TX + Transmitted data (+)
2 RX + Received data (+)
3 TX - Transmitted data (-)
4 RX - Received data (-)

Power over Ethernet (PoE) Models

Power over Ethernet models only support mode A Class 0 power levels and can be powered
by any standard endspan PSE (i.e. PoE switch).

Power over Ethernet Network Connector Pinout

Pin Name Function
1 TX +/DC- Transmitted data (+) DC power (-)
2 RX +/DC+ Received data (+) DC power (+)
3 TX -/DC- Transmitted data (-) DC power (-)
4 RX -/DC+ Received data (-) DC power (+)

These models can only supply power to the Digital Outputs directly. They

cannot power any Input devices directly nor a CBX, nor any Input/Output

devices through the CBX. If the CBX or any input devices are used for
CAUTION  these models, they must be powered separately.

ID-NET™ NETWORK TERMINATION

The network must be properly terminated by a 120 Ohm resistor at the first and last reader of
the network.
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e MATRIX 300™ REFERENCE MANUAL

INPUTS

There are two optocoupled polarity insensitive inputs available on the M12 17-pin connector
of the reader: Input 1 (External Trigger) and Input 2, a generic input. See par. 4.5 for more
details.

The electrical features of both inputs are:

INPUT [V ag| Min. ||V ag| Max. I w Max
Open ov 2V 0 mA
Closed 45V 30V 10 mA

The relative pins on the M12 17-pin connector are:

Pin | Name Function
1 Vdc Power Supply input voltage +
6 I1A External Trigger A (polarity insensitive)
5 11B External Trigger B (polarity insensitive)
13 |I2A Input 2 A (polarity insensitive)
3 12B Input 2 B (polarity insensitive)
2 GND Power Supply input voltage -

OUTPUTS

Three general purpose non opto-isolated but short circuit protected outputs are available on
the M12 17-pin connector. See par. 4.6 for more details.

The pinout is the following:

Pin | Name Function
9 o1 Configurable digital output 1
8 02 Configurable digital output 2
16 |03 Configurable digital output 3
2 GND Ouptut reference signal

The electrical features of the three outputs are the following:

Reverse-Polarity and Short-Circuit Protected
Vour A__|O>_u =0 3>v max = 30 Vdc
<OC._. A__:O>U =100 3>v max = 3 Vdc

lLoap Max = 100 mA

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.
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ALTERNATIVE CONNECTIONS

Matrix 300™

USER INTERFACE

Matrix

£
—

‘--I—-I:I-

Figure 85 - PNP Output Connection

300™

USER INTERFACE
Vext 30 Vdc max

Matrix

Figure 86 - NPN Output Connection

300™

1

>l
13

9/8/16

USER INTERFACE

i

L

T |

Figure 87 - Push-Pull Output Connection
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MATRIX 300™ REFERENCE MANUAL

USER INTERFACE - SERIAL HOST

RS232 PC-side connections

9-pin male connector

/Hooo...o.o.oHW\,

14 25

25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS

How To Build A Simple Interface Test Cable:

The following wiring diagram shows a simple test cable including power, external (push-

button) trigger and PC RS232 COM port connections.

M12 17-pin female

9-pin D-sub female

Trigger T_

17 X ~ N\ 2 Lo
- 1l RX \ / /m % ‘ PC
/ \ \m GND
4
2 _GND _
Matrix 300™ <l | o 1 vic
6 11A
5 11B
Power Supply

Power GND
VS (10 —30 VDC)

Figure 88- Test Cable for Matrix 300™
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GLOSSARY

AIM
(Association for Automatic ldentification and Mobility): AIM Global is the international trade
association representing automatic identification and mobility technology solution providers.

AIM DPM Quality Guideline

Standard applicable to the symbol quality assessment of direct part marking (DPM)
performed in using two-dimensional bar code symbols. It defines modifications to the
measurement and grading of several symbol quality parameters.

AS9132
Standard defining uniform quality and technical requirements for direct part marking (DPM)
using Data Matrix symbologies.

Barcodes (1D Codes)

A pattern of variable-width bars and spaces which represents numeric or alphanumeric data
in machine-readable form. The general format of a barcode symbol consists of a leading
margin, start character, data or message character, check character (if any), stop character,
and trailing margin. Within this framework, each recognizable symbology uses its own unique
format.

BIOS
Basic Input Output System. A collection of ROM-based code with a standard API used to
interface with standard PC hardware.

Bit

Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits
compose one byte of data. The pattern of 0 and 1 values within the byte determines its
meaning.

Bits per Second (bps)
Number of bits transmitted or received per second.

Bright Field Illumination

Lighting of surfaces at high (narrow) angles used to provide maximum reflection of the light
to the reader’s lens. This is effective on surfaces that absorb light or are not highly reflective
and also on low contrast codes.

Byte

On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to
represent a specific character or numeric value. Bits are humbered from the right, O through
7, with bit O the low-order bit. One byte in memory can be used to store one ASCII character.

Composite Symbologies
Consist of a linear component, which encodes the item's primary data, and an adjacent 2D
composite component, which encodes supplementary data to the linear component.

Dark Field Illumination

Lighting of surfaces at wide angles used to avoid direct reflection of the light into the reader’s
lens. Typically this type of lighting is used in DPM solutions to enhance reflectance of the
uneven surface do to the symbol marking technique. Is is also used with very reflective
surfaces.
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Decode

To recognize a barcode symbology (e.g., Codabar, Code 128, Code 3 of 9, UPC/EAN, etc.)
and analyze the content of the barcode scanned.

Depth of Field

The difference between the minimum and the maximum distance of the object in the field of
view that appears to be in focus.

Diffused Illlumination
Distributed soft lighting from a wide variety of angles used to eliminate shadows and direct
reflection effects from highly reflective surfaces.

Direct Part Mark (DPM)
A symbol marked on an object using specific techniques like dot peening, laser etching,
chemical etching, etc.

EEPROM
Electrically Erasable Programmable Read-Only Memory. An on-board non-volatile memory
chip.

Element
The basic unit of data encoding in a 1D or 2D symbol. A single bar, space, cell, dot.

Exposure Time
For digital cameras based on image sensors equipped with an electronic shutter, it defines
the time during which the image will be exposed to the sensor to be acquired.

Flash
Non-volatile memory for storing application and configuration files.

Host

A computer that serves other terminals in a network, providing services such as network
control, database access, special programs, supervisory programs, Or programming
languages.

Image Processing
Any form of information processing for which the input is an image and the output is for
instance a set of features of the image.

Image Resolution
The number of rows and columns of pixels in an image. The total number of pixels of an
image sensor.

Image Sensor
Device converting a visual image to an electric signal. It is usually an array of CCD (Charge
Coupled Devices) or CMOS (Complementary Metal Oxide Semiconductor) pixel sensors.

IEC
(International Electrotechnical Commission): Global organization that publishes international
standards for electrical, electronic, and other technologies.

IP Address

The terminal's network address. Networks use IP addresses to determine where to send
data that is being transmitted over a network. An IP address is a 32-bit number referred to as
a series of 8-bit numbers in decimal dot notation (e.g., 130.24.34.03). The highest 8-bit
number you can use is 254.
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ISO
(International Organization for Standardization): A network of the national standards
institutes of several countries producing world-wide industrial and commercial standards.

LED (Light Emitting Diode)
A low power electronic light source commonly used as an indicator light. It uses less power
than an incandescent light bulb but more than a Liquid Crystal Display (LCD).

LED llluminator
LED technology used as an extended lighting source in which extra optics added to the chip
allow it to emit a complex radiated light pattern.

Matrix Symbologies (2D Codes)

An arrangement of regular polygon shaped cells where the center-to-center distance of
adjacent elements is uniform. Matrix symbols may include recognition patterns which do not
follow the same rules as the other elements within the symbol.

Multi-row (or Stacked) Symbologies
Symbologies where a long symbol is broken into sections and stacked one upon another
similar to sentences in a paragraph.

RAM
Random Access Memory. Data in RAM can be accessed in random order, and quickly
written and read.

Symbol Verification
The act of processing a code to determine whether or not it meets specific requirements.

Transmission Control Protocol/Internet Protocol (TCP/IP)

A suite of standard network protocols that were originally used in UNIX environments but are
now used in many others. The TCP governs sequenced data; the IP governs packet
forwarding. TCP/IP is the primary protocol that defines the Internet.
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